
 
 
Distributor Technical Reference Bulletin 
 
Bulletin Number:  DTR-2004-0462-Global-Rev 5 
Date:    October 10, 2006  
 
 

CallPilot Release 3.0 
 
 
Introduction 
 
This Distributor Technical Reference (DTR) bulletin provides information that supplements 
the formal documentation for the purpose of installing, upgrading, and supporting CallPilot 
Release 3.0 (03.03.06.02) systems.  It provides updated procedures, limitations, known 
problems, workarounds, and documentation addenda.  This is an important information 
resource for Channel Partner field operations and support personnel involved with 
CallPilot 3.0. 
 
For more details on feature installation and operation, refer to the CallPilot 3.0 Customer 
Documentation. 
 
This document, as well as other Customer Documentation, may be updated periodically as 
needed.  It’s recommended to always reference the Partner Information Center and 
Helmsman Express websites for the latest information in updated NTPs or Release Notes 
documents. 
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1 The Distributor Technical Reference Bulletin 
 

1.1 Purpose 
 
The purpose of the Distributor Technical Reference bulletin (DTR) is to provide the user with 
information for CallPilot 3.0 that is not covered by the NTP documentation supplied with the system.  
This DTR is intended for use in conjunction with the latest CallPilot 3.0 (03.03.06.02) software CDs.   
Refer to the complete listing in CallPilot Software. 
 
 

1.2 What’s new in CallPilot 3.0 
 
While CallPilot 3.0 primarily focuses on rebasing the CallPilot application to the Windows 2003 Server 
Operating System (OS), it also includes the following improvements/enhancements: 
 

• Simplified system re-installation process using “Image” CDs 
• Hardware alignment between 703t and 1002rp 

o 1002rp Rackmount platforms now ship with MPB96 board instead of MPB16 
• Two additional languages (Australian English and Japanese) 
• Enhanced and condensed documentation suite including two new guides:  

o “Installation and Configuration Task List” for procedures-based tasks 
o “CallPilot Fundamentals” for an overview of all CallPilot components 

• “Unified” Application Builder client that functions with 2.02/SU02 and later and 3.0 servers 
• Incorporates all improvements/enhancements available from CallPilot 2.02/Service Update 3 

(SU03) and Service Update 4 and CallPilot 2.5/Service Update 2.  
• Includes new version of Symantec pcAnywhere (11.0) 
• Includes new version of Adobe Acrobat (6.0) 
• Includes fully licensed version of Symantec Ghost (7.5 – Corporate Edition) 

o Can be used for imaging the CallPilot server 
• Offers Microsoft Remote Desktop Connection (RDC) as maintenance remote control option to 

pcAnywhere on 703t Tower and 1002rp Rackmount servers 
o Required for 201i IPE servers; reference bulletin P-2005-0026-Global for details 

 
 

1.3 Supported Operations 
 

1.3.1 Features on Controlled Release 
 

The following is a list of 3.0 features that are on controlled release.  
• Speech Recognition and Custom Commands for languages other than North American 

English and German 
• Email-by-Phone languages other than Dutch, English, French, German, Italian, Russian, 

and Spanish,  (using either Western European ISO-8859-1 or UTF-8 message encoding) 
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1.3.2 Switch Integrations supported 
 

The following switch integrations are supported: 
• Meridian 1, Option 11C to 81C 
• Communication Server 1000/1000M/1000E 
 
1.3.3 Switch Integrations deferred 

 
The following switch integrations will be supported in CallPilot 4.0: 
• Meridian SL-100 
• DMS-100 Centrex (with CallPilot at customer site) 

 
1.3.4 Server and Client Upgrades supported 

 
No upgrades from previous CallPilot releases will be supported with CallPilot 3.0.  Upgrade 
support from CallPilot 2.02 and 2.5 are supported with CallPilot 4.0.. 

 
 

1.4 About Customer Documentation 
 
The starting point for all CallPilot activities is the customer documentation that is included with the 
system.  The CD-ROM titled “CallPilot Product Release 3.0 Documentation on CD-ROM” (NTRG19AK for 
English) contains all of the customer documentation available.  
 
The documentation CD-ROM can be viewed on any PC using Adobe Acrobat Reader 4.0 or later (the 
Adobe software is included on the CD).  
 
Note: These documents, as well as other Customer Documentation, may be updated periodically as 
needed.  It’s always recommended to reference the Partner Information Center and Helmsman Express 
websites for the latest information in updated NTPs or Release Notes documents. 
 
 

1.5 Software Updates/Enhancements 
 
After installation is completed, verify whether there are any additional PEPs to be installed.  At the time 
of updating this document, CallPilot 3.0 Service Update 1 was available Refer to PEP/Service Update 
application overview for additional information. 
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1.6 Localized Media 
 
The table below summarizes the localized CallPilot 3.0 media available: 
 

Language 
Voice 

Prompts
Desktop 

Messaging My CallPilot

Speech 
Activated 

Messaging 

E-mail 
by 

Phone 

End-
User 
Docs

Arabic       
Cantonese  
(Traditional Chinese)  2.01.27.16 

only     

Czech        
Danish       
Dutch       
English, American (US)       
English, Australian       
English, Canadian       
English, Irish       
English, UK (Female)       
Finnish       
French, Canadian       
French, European       

German   2.01.27.09 
only    

Greek       
Hebrew       
Hungarian       
Italian       
Japanese       
Korean       
Norwegian       
Polish       
Portuguese, Brazilian       
Portuguese, European       
PRC Mandarin 
(Simplified Chinese)       

Russian       
Spanish, Castilian 
(European)       

Spanish, Latin American       
Swedish       
Taiwanese Mandarin 
(Traditional Chinese)  2.01.27.16 

only     

Thai       
Turkish       
 
Notes: 

1. Desktop Messaging Languages (Software and Help).  2.50.06.17 provides localized versions of 
the product (Dutch, English, French, German, Italian, Spanish, or Simplified Chinese). 
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2. My CallPilot Languages (Software and Help).  2.50.06.23 is currently available in English and 
French only. 

3. Email-by-Phone languages are not localized by dialect.  For example, there is only one 
“English” version of Email-by-Phone that is deployed with all five English prompt sets. 

4. End-user documentation is not localized by country.   For example, customers in France and 
Quebec, Canada would use the same end-user documents.   

5. Localized end-user documentation is available from the Helmsman web site. 
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2 Product Requirements 
 

2.1 CallPilot 3.0 Compatibility 
 
The following tables define CallPilot 3.0 compatibility with other products and environments it is likely 
to encounter. 
 

Product / Function CallPilot 3.0 Compatibility 
Meridian Mail • Co-existence with Meridian Mail on Meridian 1 or 

Communication Server 1000/1000M/1000E is supported.  
Networking to Meridian Mail available with AMIS-A and 
Enterprise networking protocols or via VPIM with Meridian 
Mail Net Gateway.  However, there are limitations.  

Meridian Mail Reporter • Cannot be used to generate reports from a CallPilot server.  
Meridian Mail Reporter only supports Meridian Mail and 
CallPilot Reporter only supports CallPilot. 

Meridian Administration Tool 
(MAT) or Optivity Telephony 
Manager (OTM)  

• Co-existence of CallPilot Application Builder client with 
MAT 6.x and OTM 1.x and 2.x clients on the same PC is 
supported. 

• Please see Product bulletin 99092 for the CallPilot website 
for a detailed listing of compatibility with MAT. 

Custom Controlled Routing 
(CCR) 

• Co-existence of CCR and CallPilot on the same Meridian 1 is 
supported.   

• CallPilot does not support CCR command: Give IVR.   
Symposium Call Center Server 
1.x, 3.0, and 4.x, 5.0 
Symposium Express 1.0 and 
2.0, 3.0, and 4.2 
Contact Center - Manager 
Server (CCMS) 6.0 

• Co-existence with Symposium Call Center Server or Express 
on the same M1/CS 1000 and ELAN is supported. 

• CallPilot 3.0 supports Symposium Call Center Server 4.2 and 
later integration for voice processing script commands: 
“Give IVR”, “Give Controlled Broadcast”, “Collect Digits”, 
“Play Prompt”, “Open…End Voice Session” but requires 
PEP SU-07 or later.   

• CallPilot 3.0 supports Symposium Express 4.2 integration 
for voice processing script commands “Give IVR” also 
requires PEP SU-08 or later.  

• CallPIlot 3.0 supports Contact Center – Manager Server 6.0 
Internet Telephony Gateway 
(ITG) 

• CallPilot AMIS-Analog and Enterprise Networking is 
supported with ITG R1.1 (v1.0.34 or later).   

• Network Message Service (NMS) support requires ITG 2.0. 
Microsoft Office 2000 and 
2002 (XP), 2003 

• CallPilot 2.5 Desktop Messaging clients are compatible 
• CallPilot 3.0  and 4.0 Application Builder client is 

compatible 
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2.1.1 Migration from Meridian Mail 
 
Migration from Meridian Mail systems to CallPilot 3.0 is supported using the Meridian Mail migration 
utility tape NTUB25AB (available within NTUB24AD Migration Package).  This supports migration 
from all Meridian Mail MM11, MM12, and MM13 releases for all Meridian Mail platforms except the 
MSM and Card Option running MM13.11.2.  It is required for all Meridian Mail releases including 
MM13.14 as this tape supersedes the migration utility available in the TOOLS level.   
 
Note:  Previous 1.07 versions of the migration utility NTUB24AA or NTUB24AB cannot be used with 
CallPilot 3.0.   The Migration guide should be consulted for limitations. 
 
Note:  CallPilot requires use of the NTRB18CA MGate card for connectivity.  Systems migrated from 
Meridian Mail must ensure only the updated MGate cards are used. 
 
Note:  Unlike Meridian Mail where calls were directly routed to the main ACD-DN (queue) feeding 
Meridian Mail ports, a CDN is used to route calls to CallPilot.  It is imperative that all calls be routed 
through the CDN and not directly to the ACD-DN associated with CallPilot channels.  See the 
Migration guide for details. 
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2.1.2 Application Builder client / Operating System (OS) compatibility 
 

Operating Systems: 2.02/2.5 3.0 
Windows 95 or 95A w/ Service Pack 1   
Windows 95B OEM Service Release 2 (OSR2)   
Windows 98   
Windows 98SE (Second Edition)   
Windows ME   
Windows NT 4.0 Workstation (Service Pack 1)   
Windows NT 4.0 Workstation (Service Pack 2)   
Windows NT 4.0 Workstation (Service Pack 3)   
Windows NT 4.0 Workstation (Service Pack 4)   
Windows NT 4.0 Workstation (Service Pack 5)   
Windows NT 4.0 Workstation (Service Pack 6)   
Windows NT 4.0 Workstation (Service Pack 6A)   
Windows NT 4.0 Server   
Windows 2000 Professional  
(ISO-8859-1, Latin-1 character set versions) Note 3 Note 3 

Windows 2000 Server and Advanced Server   
Windows XP Home   
Windows XP Professional   
Windows 2003 Server   
Macintosh OS 9.0 or 9.1   
Macintosh OS X   

 
Notes:  

1. CallPilot 4.0 Application Builder client is backward compatible for use with CallPilot 
2.02/SU03 and later servers. 

2. CallPilot 1.07 and 2.x (2.02 pre-SU03 and 2.5 pre-SU02) Application Builder clients are not 
compatible with 3.0.   

3. ISO-8859-1 (Latin-1) character sets cover most West European languages including but not 
limited to: English, French, Spanish, Catalan, Basque, Portuguese, Italian, Albanian, Rhaeto-
Romanic, Dutch, German, Danish, Swedish, Norwegian, Finnish, Faeroese, Icelandic, Irish, 
Scottish, Afrikaans, and Swahili. 
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2.1.3 Desktop Messaging / Groupware compatibility 
 

CallPilot Desktop Messaging and My CallPilot support the following Groupware e-mail clients, 
Internet mail clients, Web clients, and thin clients: 
 

Groupware E-mail clients  1.07.11.24  2.50.06.17 
Microsoft Exchange 4.x   
Microsoft Exchange 5.x   
Microsoft Outlook 97   
Microsoft Outlook 98 
(Corporate Mode)   

Microsoft Outlook 2000   
Microsoft Outlook 2002 (XP) Note 4  
Microsoft Outlook 2003    
Lotus Notes 4.5x   
Lotus Notes 4.6x   
Lotus Notes 5.0x   
Lotus Notes 6.0   
Lotus Notes 6.5    
Novell GroupWise 5.5x   
Novell GroupWise 6.0x   
Novell GroupWise 6.5   
Internet Mail clients 1.07.11.24 2.50.06.17 
Microsoft Outlook Express 4.x (Internet Explorer 4.0)   
Microsoft Outlook Express 5.x   
Microsoft Outlook Express 6.x   
Microsoft Outlook 98  
(Internet Mail Mode)   

Microsoft Outlook 2002 (XP) (Internet Mail Mode)   
Microsoft Outlook 2003 
(Internet Mail Mode)   

Netscape Messenger (Netscape Communicator) 4.5   
Netscape Messenger (Netscape Communicator) 4.6   
Netscape Messenger (Netscape Communicator) 4.7x   
Netscape 6.2x   
Netscape 7.0, 7.1, and 7.2   
Qualcomm Eudora Pro 4.02   
Qualcomm Eudora Pro 4.2   
Qualcomm Eudora Pro 5.x   
Thin clients 1.07.11.24 2.50.06.17 
Citrix Metaframe 1.8 on Windows 2000 Server, Windows 
2000 Advanced Server, or Windows 2000 Datacenter Server   

Citrix MetaFrame XP (Standard, Enterprise, or Advanced 
Editions) on Windows 2000 Server, Windows 2000 
Advanced Server, or Windows 2000 Datacenter Server 
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Supplemental Version Notes: 

Desktop Messaging client version 2.50.06.17: 
1. Is supported for use with CallPilot 3.0, 2.02, and 2.5 servers. 
2. Offers localization. 
 
1.07 Desktop Messaging clients: 
3. Are not supported for use with a 2.02/2.5 or 3.0 server due to reduced functionality: 

o Telset operations do not function (PC Playback does) 
o Unable to download address book; addressing will be manual 

 
Important: It is highly recommended that all Desktop Messaging clients utilize the 2.5 version 
with CallPilot release 3.0 (03.03.06.02).  This will ensure maximum functionality. 

 
4. Only Desktop Messaging client version 1.07.11.24 (Service Update 5) and later support 

Windows XP Professional  
 

1.06/1.05 Desktop Messaging clients: 
5. Are not supported for use with a CallPilot 3.0 or 2.02 servers. 

 
2.1.4 Desktop Messaging client / Operating System (OS) compatibility 

 
Desktop Messaging clients are supported for use on the following Operating Systems: 

 

Operating Systems 1.07.11.24 
2.50.06.17 
and later 

Windows 95 or  
Windows 95A w/ Service Pack 1   

Windows 95B OEM Service Release 2 (OSR2)   
Windows 98   
Windows 98SE (Second Edition)   
Windows ME   
Windows NT 4.0 Workstation (Service Pack 1)   
Windows NT 4.0 Workstation (Service Pack 2)   
Windows NT 4.0 Workstation (Service Pack 3)   
Windows NT 4.0 Workstation (Service Pack 4)   
Windows NT 4.0 Workstation (Service Pack 5)   
Windows NT 4.0 Workstation (Service Pack 6)   
Windows NT 4.0 Workstation (Service Pack 6A)   
Windows NT 4.0 Server   
Windows 2000 Professional   
Windows 2000 Server, Advanced, or  
Data Center Server   

Windows XP Home   
Windows XP Professional (Service Pack 2)   
Windows 2003 Server   
Macintosh OS 9.0 or 9.1   
Macintosh OS X   
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2.1.5 My CallPilot / Browser compatibility 
 

My CallPilot Web Messaging supports the following Internet browsers: 
 

Internet Browsers 
2.02 

(2.01.27.09) 
2.5 

(2.50.06.08) 
2.5 

(2.50.06.19) 
2.5 

(2.50.06.22) 
2.5 

(2.50.06.23) 
Netscape Navigator 4.0x      
Netscape Communicator 4.5      
Netscape Communicator 4.6      
Netscape Communicator 4.7x      
Netscape 6.2x for Windows and 
Mac      

Netscape 7.0, 7.1, and 7.2 for 
Windows and Mac      

Microsoft Internet Explorer 4.x      
Microsoft Internet Explorer 5.x 
for Windows and Mac      

Microsoft Internet Explorer 6.0 
for Windows      

 
2.1.6 My CallPilot client / Operating System compatibility 
 
My CallPilot clients are supported for use on the following Operating Systems: 

 

Operating System 
2.02 

(2.01.27.09) 
2.5 

(2.50.06.08) 
2.5 

(2.50.06.19) 
2.5 

(2.50.06.22) (2.5
Windows 95 or 95A w/ Service Pack 1     
Windows 95B OEM Service Release 2 (OSR2)     
Windows 98     
Windows 98SE (Second Edition)     
Windows ME     
Windows NT 4.0 Workstations (Service Pack 1)     
Windows NT 4.0 Workstations (Service Pack 2)     
Windows NT 4.0 Workstations (Service Pack 3)     
Windows NT 4.0 Workstations (Service Pack 4)     
Windows NT 4.0 Workstations (Service Pack 5) Note 7    
Windows NT 4.0 Workstations (Service Pack 6)     
Windows NT 4.0 Workstations (Service Pack 6A)     
Windows NT 4.0 Server     
Windows 2000 Professional     
Windows 2000 Server,  
Advanced or DataCenter Server     

Windows XP Home     
Windows XP Professional     
Windows 2003 Server     
Macintosh OS 9.0 or 9.1     
Macintosh OS X     
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Notes: 
1. With CallPilot 2.02 (using My CallPilot version 2.01.27.09), only partial support for Mac OS 9.0 

and 9.1 is available via My CallPilot when accessed with Internet Explorer or Netscape.  Partial 
support functionality is read-only, listen-only mode similar to the web-messaging functionality 
provided in CallPilot 1.07.  Also, no CallPilot Player, CallPilot Fax Viewer, or interaction with 
the TUI will be available.  Listening to and viewing of CallPilot messages will be accessed via 
desktop only and handled by the resident audio player and picture viewer of the MAC OS. 

2. With CallPilot 2.5 (using My CallPilot version 2.50.06.04 and later), full support of Mac OS 9.0 
and 9.1 is available via My CallPilot accessed with Internet Explorer or Netscape.   Full support 
means that Mac users will now be able to Compose, Send, Reply to messages, as well as utilize a 
CallPilot Player and Fax Viewer. 

3. Partial support for Mac OS X is supported with My CallPilot version 2.50.06.11 and later.  The 
functionality is the same as outlined above for the CallPilot 2.02 Mac My CallPilot Web Client.  
Any prior release of My CallPilot is not supported.  

 
 

2.1.7 Supported server OS and Internet Browsers for use with My CallPilot, 
CallPilot Manager, and Reporter 

 
CallPilot 3.0 My CallPilot, CallPilot Manager, and Reporter support the following operating 
systems and browsers: 

 
Product / Function CallPilot 3.0 Compatibility 
Server side details:  
Operating Systems • Windows NT 4.0 Server, Service Pack 6A  

• Windows 2000 Server with Service Pack 1 or later 
(Note: Advanced Server and DataCenter Server 
versions are not supported.) 

• Windows 2003 Server , Service Pack 1 or later  
Internet Service software 
 

• Internet Information Server 4.0 
• Internet Information Server 5.0 (Service Pack 1 or 

later) 
• Internet Information Server 6.0 

Client side details:  
Operating Systems • Windows 98SE 

• Windows NT 4.0 workstation (Service Pack 6A) 
• Windows 2000 Professional 
• Windows XP Professional 
• MAC OS 9.0 and 9.1 (for My CallPilot only)  
• MAC OS X – partial support (for My CallPilot only) 

Browsers • Netscape Communicator 6.2x (with proper Java 
J2SE extension.  See note.) 

• Netscape Communicator 7.0, 7.1, and 7.2 
• Internet Explorer 5.x, 6.x (with proper Java J2SE 

extension.  See note.) 
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Notes:   

• If Desktop Messaging and Web Messaging are installed on the same client PC, CallPilot 
Web Messaging will be compatible with all 2.x versions of the player. 

• When using CallPilot Reporter, for proper operation of Java on Netscape 6.2 or Microsoft 
Internet Explorer 6.x, J2SE version 1.3.1_05 must be installed.  If you have an earlier or 
later version of J2SE, it must be uninstalled first.  J2SE versions can be downloaded from 
http://www.java.sun.com. 

• Javascript and Cookies must be enabled in the web browser. 
• Support for localized browsers is available in Dutch, English, French, German, and 

Traditional Chinese. 
• CallPilot 3.0 “My CallPilot” does not support Windows 95. 

 
2.1.8 Requirements for CallPilot Manager stand-alone web servers 

 
The requirements for the stand-alone web server for installing CallPilot Manager (with or 
without CallPilot Reporter) and My CallPilot are as follows. 

 
Supported Operating Systems Supported 
Windows NT 4.0 server with SP6a and Microsoft 
Internet Information Server (IIS) 4 Yes 

Windows 2000 server with SP1 or SP2 and Microsoft 
Internet Information Server (IIS) 5 Yes 

Windows Server 2003 Release 2  Yes 
Windows 2003 Standard Edition and Microsoft 
Internet Information Server (IIS) 6 Yes 

Windows 2003 Web Edition and Microsoft Internet 
Information Server (IIS) 6 Yes  

Windows 2003 Enterprise Edition and Microsoft 
Internet Information Server (IIS) 6 Yes  
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2.1.9 Platform Hardware/BIOS/Software requirements 
 

This list is intended to be used in addition to the requirements that are captured in the current 
issue of the CallPilot 3.0 NTP documentation. 

 
Platform Component Version 
201i BIOS 6.0.3 

BIOS 16 Build 75 
703t Firmware  FRU SDR 5.5 

BMC 1.18 
1002rp BIOS NNCXUA07 
MPB96 Release 6 (Minimum)  
LSI MegaRaid 1600 Firmware 111U 
LSI MegaRaid 1600 Firmware 1L37 

 
2.1.10 Supported customer LANs 

 
Product / Function CallPilot 3.0 Compatibility 
10Base-T All platforms 
100Base-T 201i (IPE), 703t (Tower),  and 1002rp (Rackmount) without 

additional hardware (see note) 
1000Base-T 703t (Tower) 

 
 Notes:   

• All other platforms include 10/100Base-T Ethernet LAN NIC cards except 703t, which 
includes 10/100/1000Base-T Ethernet LAN NIC. 

• Token Ring (4 or 16 Mbps) LAN is not supported in CallPilot 3.0. 

• ELAN must be configured for 10Base-T/Full duplex. 

• If a switch is used for ELAN or CLAN, “Spanning Tree” must be turned off. 

• CLAN should be configured for Auto-Detect. 

 
2.1.11 Supported LAN/WAN Networking Protocols 

 
CallPilot supports only TCP/IP (internet) networking protocols.  Novell’s IPX/SPX protocol is not 
supported. 
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2.2 Operational Requirements 
 

2.2.1 3rd-party software and hardware 
 
The addition of any 3rd-party software or hardware to the CallPilot server is not supported other 
than approved anti-virus applications (Refer to Product Bulletin P-2003-0151-Global – CallPilot 
Support for Anti-Virus Applications for details) or approved Microsoft security updates (Refer to 
Product Bulletin P-2006-0011-Global-Rev10 – CallPilot Server Security Update or published 
Clarify Bulletin System - Product Security Advisory Alerts).  Doing so can destabilize the system; 
degrade its mission of providing real-time call processing performance, and cause future upgrades 
to fail.  Refer to Product Bulletin 99067 – CallPilot Unauthorized Hardware and Software for more 
information. 
 

2.2.2 Software dongle installation 
 
The CallPilot dongle must be properly installed in the server prior to accessing CallPilot Manager. 
 

2.2.3 Proper Power and Grounding 
 
All CallPilot server installations (201i, 703t, and 1002rp) must follow the Meridian 1 and/or 
Communication Server 1000/1000M/1000E and CallPilot NTP guidelines for proper power and 
grounding, specifically, adhering to the Single-Point Ground Reference requirement.  Failure to follow 
these guidelines makes Meridian 1/Communication Server 1000/1000M/1000E and CallPilot 
susceptible to damage from electrical transients resulting from lightning and other power-ground 
disturbances. 

 
The Single-Point Ground Reference includes all powered devices that attach directly to the 
PBX and its ancillary equipment.  For a typical CallPilot installation, the following components 
are included: 

• PBX 
• CallPilot server 
• Uninterruptible Power Supply (UPS) (if installed) 
• Remote maintenance modem 
• ELAN and CLAN hubs 
• Administration/Maintenance PC (and associated monitor and printer) 
• External CD-ROM and Tape drives (for 200i and 201i IPE servers) 
• Symposium Call Center Server (if installed) 

 
As well, in CallPilot Rackmount server installations, the following supplemental information 
applies: 

• Ensure the CallPilot server chassis and equipment racks are isolated from other foreign 
sources of ground 
• Acceptable isolation methods include: isolation pads, grommet washers, chassis 

side rail strips and non-conducting washers, etc 
• Where other equipment is also installed in the same 19" rack, ensure that all equipment 

derives ground from the same service panel as CallPilot and the switch, whether or not 
the equipment is AC or DC powered. 
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• In DC-powered server installations, ensure the PDU (Power Distribution Unit for DC 
applications) is installed on the same rack as the CallPilot server.  This is required since 
the main ground wire for the PDU is not insulated from the metal enclosure. 

 
It’s also highly recommended that a UPS be equipped on Tower/Rackmount installations. 

 
Important Note: Adherence to a Single-Point Ground reference applies to all existing installed-base 
systems as well as new CallPilot server installations.  Whether working on a new install or performing 
maintenance on an existing system, verifying the system is properly grounded can help avoid damage or 
system outage from electrical transients. 
 

2.2.4 Shutdown/Restart required after PBX maintenance procedures 
To ensure proper operation of the CallPilot server after performing a SYSLOAD or Parallel 
Reload of the PBX, the CallPilot server must be rebooted to ensure all resources are properly re-
acquired.   As well, when possible, it’s preferred that the CallPilot server be taken offline during the 
maintenance procedure and then restarted once the PBX work has been completed. 

 
To perform a proper CallPilot shutdown/restart, use “Ctrl-Alt-Delete” and select “Shutdown” 
from the Windows Security window.  Then from the Shutdown Computer dialog box that appears, 
select either “Shutdown” or “Shutdown and Restart” as appropriate. 

 
2.2.5 201i IPE recommended handling procedures 

 To minimize data loss or damage to the drive media, when removing power from the 200i or 201i 
IPE server, ensure the system avoids excessive vibration until the hard drive heads have parked 
using the recommending handling procedure below.  . 

1. Perform a shutdown 
2. Remove power by gently unseating the server from the backplane 
3. Allow the server to remain still for approximately 15 seconds.  This allows the drive 

heads to park to a “safe” zone. 
4. Remove the IPE server as handle as normal following ESD guidelines. 
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3 Meridian 1 switch requirements 
 
NTP 555-7101-222 – CallPilot Installation and Configuration Guide – Part 3 – Meridian 1 and CallPilot Server 
Configuration.  Chapter 3 describes how to configure a Meridian 1 PBX to work with CallPilot.  The 
following description is an addendum to this chapter, describing the specific Meridian 1 models 
supported, the supported X11 software releases, and the PEPs available for the various releases for 
proper CallPilot operation.   
 
Section 3.1 lists the supported Meridian 1 models.  Section 3.2 identifies the supported software releases.  
Section 3.3 lists required packages relevant to CallPilot.  Section 3.4 provides a list of the available PEPs 
with a description of the issues addressed and its applicability to the system model and software release. 
 
Note:  Information on the X11 software changes regularly.  For the most recent information on 

supported X11 software releases and PEPs refer to the Nortel Networks Enterprise Solutions 
PEP Library (ESPL) website at: http://www.nortelnetworks.com/espl (all regions) 
 

Note:  If you are new to the ESPL website, you will need to register for a user ID/password.  Please 
apply on-line at http://www.nortelnetworks.com or contact Nortel Networks Channel Partner 
Account Manager.  

 
 

3.1 Meridian 1 switches supported 
 
Meridian 1 - Options 11C, 11C/Mini, 51C, 61C, 81, 81C 
 
Note: The copper-connection Option 11C does not support ELAN, which is required for CallPilot. 
 
 

3.2 Software Releases supported 
 
For switch software releases supported are X11R25.40 or later.   
 
  

3.3 X11 Packages required for CallPilot 3.0 
 

Pkg # Description  Package 324 requirements 
41 ACDB (ACD Package B)  Pkg # Description 
46 MWC (Message Waiting Center)  77 CSL (Command Status Link) 

214 EAR (Enhanced ACD Routing)  153 X25AP (Application Module Link – 
AML) 

215 ECT (Enhanced Call Treatment)  164 LAPW (Limited Access to Overlays) 
218 IVR (Hold in Queue for IVR)  242 MULI (Multi-User Login) 
247 Call ID  243 Alarm Filtering 

324 NGEN (CallPilot Connectivity) 
See next table 

 296 MAT (Meridian Administration Tool)

364 NMCE (CallPilot)   
254 PHTN (Phantom TN)    
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3.4 X11 PEPs to support CallPilot 3.0 
 
It is highly recommended to review the following bulletins located at  
http://www.nortelnetworks.com/espl for supplemental PEPs that might be applicable. 
.   

• X11 Release 25.40/25.40B and X21 Release 2 DepList Integration Bulletin 
• X11 Release 25.47 DepList Integration Bulletin 
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4 Communication Server 1000 switch requirements 
 
Communication Server 1000/1000M/1000E (a.k.a. Succession 1000/1000M/1000E) is a 
communications system that provides a single solution for telephony and data capabilities.  
Communication Server 1000/1000M/1000E provides a full suite of industry-leading voice features and 
uses global software.  The software stream used on a Communication Server 1000 is X21, which delivers 
software with equivalent features and functionality to Meridian 1 X11 25.30 and later.  This software 
stream provides the same seamless integration between CallPilot and Communication Server 
1000/1000M/1000E as between CallPilot and Meridian 1. 
 

4.1 CallPilot Platforms Supported 
 

• 201i IPE   
• 703t Tower 
• 1002rp Rackmount  

Please refer to NTP 555-7101-510 CallPilot Installation and Configuration Guide – Part 3 – Succession 
1000 and CallPilot Server Configuration, for further details on Communication Server 1000 and the 
installation and configuration of CallPilot with this switch. 

 
4.2 Software Releases supported 

 
• X21 release 3.0 and later. 
• CallPilot 3.0 with the CallPilot Integration/Connectivity Code: NTZE39JB 

 
4.3 X21 Packages required for CallPilot 3.0 

 
Pkg # Description  Package 324 requirements 

41 ACDB (ACD Package B)  Pkg # Description 
46 MWC (Message Waiting Center)  77 CSL (Command Status Link) 

214 EAR (Enhanced ACD Routing)  153 X25AP (Application Module Link – 
AML) 

215 ECT (Enhanced Call Treatment)  164 LAPW (Limited Access to Overlays) 
218 IVR (Hold in Queue for IVR)  242 MULI (Multi-User Login) 
247 Call ID  243 Alarm Filtering 

324 NGEN (CallPilot Connectivity) 
See next table 

 296 MAT (Meridian Administration Tool)

364 NMCE (CallPilot)   
254 PHTN (Phantom TN)    

 
All the above software packages are already included in the Communication Server 1000 Basic Software 
Service package.  However, if you also need the CallPilot Network Message Service (NMS) feature, you 
need to order either the Advanced Software Service package or the Premium Software Service package.   
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4.4 X21 Release 3.0 PEPs to support CallPilot 3.0 
 

It is highly recommended to review  the following bulletins located at  
http://www.nortelnetworks.com/espl for supplemental PEPs that might be applicable. 

 
• X21 Release 3.0 DepList Integration Bulletin 

 
 

 
 

 
Nortel – Document # P1002957  Page 24 of 105 

http://www.nortelnetworks.com/espl


5 CallPilot software 
 

5.1 CallPilot CD suite 
 
The table below identifies the CDs contained in the CallPilot 3.0 Software packages.  Ensure you have the full 
set of CDs prior to performing any maintenance activity. 
 

PEC CPC Label Version Date Notes
NTUB50BA N0002819 201i Platform 3.0 Image (2 CD set) 03.03.06.02 21-Jan-05 1 
NTUB50EA N0002825 703t Platform 3.0 Image (2 CD set) 03.03.06.02 12-Oct-04 1 
NTUB50FA N0002826 1002rp Platform 3.0 Image (2 CD set) 03.03.06.02 12-Oct-04 1 
NTUB40AG A0550943 3.0 Applications CD 03.03.06.02 18-Jan-05  
NTUB50AA N0002818 3.0 PEP CD 03.03.06.02 21-Feb-05  
NTUB41CA N0025456 Desktop Messaging software CD 02.50.06.17 23-Nov-04 4 
NTUB48AC A0518670 2.5 My CallPilot software/updates CD 02.50.06.23 20-Sep-04 4 
NTUB44AF A0550937 3.x Language Prompts – Americas (1 of 3) 02.01.27.06 04-Nov-03 2 
NTUB44BF A0550938 3.x Language Prompts – EMEA (2 of 3) 02.01.23.13 06-Aug-04 2 
NTUB44CF A0550939 3.x Language Prompts – Asia/Pac (3 of 3) 02.01.23.13 06-Aug-04 2 
NTRG19AK N0000150 3.0 Documentation CD (English)  22-Nov-04  

     
Notes: 

1. Which platform-image CDs are shipped, NTUB50BA, NTUB50EA, or NTUB50FA depends on which 
platform was ordered.   

2. Updated language CDs will be made available periodically as language localization completes.  Refer to 
the Language Availability table for details.  Language CDs are interchangeable for use with all 2.x and 
3.x servers. At the time of this print, the following CallPilot 4.0 Language CDs are available: 

 
PEC CPC Label Version Date Notes
NTUB44DA A0550937 4.x Language Prompts – Americas  04.04.04.00 8-Jul-05 2 
NTUB44EA N0032923 4.x Language Prompts – EMEA  04.04.04.02 15-Jan-06 2 
NTUB44FA N0032924 4.x Language Prompts – Asia/Pac 04.04.04.01 15-Oct-05 2 

 
3. Desktop Messaging software CD version 2.50.06.17 contain support for localized languages  

(refer to the Localized Media table for details. 
4. My CallPilot CD  version 2.50.06.22 and later contain support for localized languages  

(refer to the Localized Media table for details) 
5. At the time of updating the documents available CallPilot 4.0 Application Builder and CallPilot Manger 

recommended to be used with CallPilot 3.0 are: PEP CP404S02G08C CallPilot Manager 4.0 
(04.04.04.12) and PEP CP404S02G05A Application Builder 4.0 (04.04.04.04). They can be obtained 
from the ESPL PEP Library. 

 
 

5.2 Default Passwords 
 
CallPilot servers are shipped from the factory with the Windows 2003 Operating System and CallPilot 
application software pre-installed with the default passwords listed below.  These default passwords also apply if 
re-installing CallPilot software via the “Image” CDs. 
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Description Account Default Password 
Windows Administrator Administrator Bvw_250!# 

CallPilot system Ngensys Bvw_250!# 
CallPilot Distributor Ngendist Bvw_250!# 

CallPilot Manager 000000 124578 
pcAnywhere CallPilotDist <configured by installer> 

 
Note:  Sites using a non-North American (US) keyboard, may encounter issues when initialing 
attempting to log into the server.  To overcome this, enter the password using keystrokes similar to a 
US-keyboard.  For example, when entering “Bvw_250!#”, use shift-3 to indicate the “#” character. 
Note:  When logging into an account, or running Configuration Wizard for the first time, you must change the 
passwords.   
 
Note:  Strong passwords have been enabled for Windows 2003 accounts (NGenSys, NGenDesign, 
NGenDist, and Administrator).  When you change these passwords using Configuration Wizard, you 
can no longer use simple passwords.  As with all accounts, it is highly recommended that strong 
passwords be utilized. 
 
A strong password contains a minimum of six characters and includes a mixture of uppercase, 
lowercase, symbols, and numerals.  For example: J*p2leO4>F. 
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6 Feature Information and  Limitations 
 

6.1 Language Availability 
 
At the time of this printing, CallPilot 3.0 provides support for the following languages: 
 

CD version Language 
filename Language 

Americas (04.04.04.00) Lang1046 Brazilian Portuguese 
 Lang1033 English (American) 
 Lang4105 English (Canadian) 
 Lang3084 French (Canadian) 
 Lang3082 Latin American Spanish  
EMEA  
(04.04.04.01) Lang1025 Arabic 

 Lang1027 Catalan 
 Lang1029 Czech 
 Lang6 Danish 
 Lang1043 Dutch (Standard) 
 Lang2057 English (Female European) 
 Lang6153 English (Irish) 
 Lang 2070 European Portuguese  
 Lang11 Finnish 
 Lang1036 French (Standard) 
 Lang1031 German (Standard) 
 Lang1032 Greek 
 Lang1037 Hebrew 
 Lang1038 Hungarian 
 Lang1039 Icelandic 
 Lang1040 Italian 
 Lang1044 Norwegian 
 Lang1045 Polish 
 Lang25 Russian 
 Lang1034 Spanish (European) 
 Lang29 Swedish 
 Lang1055 Turkish 
Asia/Pacific 
(04.04.04.01) Lang3076 Chinese (Cantonese) 

 Lang1042 Korean 
 Lang3081 English (Australian) 
 Lang17 Japanese 
 Lang1028 Mandarin Chinese (Taiwan) 
 Lang2052 PRC Mandarin 
 Lang1054 Thai 
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6.2 Speech Activated Messaging and Custom Commands 
 

The Speech Activated Messaging and Custom commands features are currently only supported using 
North American English and Canadian English languages (found on the Americas language CD 
NTUB44DA / A0550937) and German (found on the EMEA language CD NTUB44EA / 
N0032923). 
   
The following Speech Activated Messaging and Custom Commands languages remain on controlled 
release.  The language CDs will be up-issued at a later date: 

• Euro French 
• UK English 
• Italian 
• Japanese 
 
6.3 Meridian Mail Migration 
 

Migration from Meridian Mail systems to CallPilot 3.0 is supported using the Meridian Mail migration 
utility tape NTUB25AB (available within NTUB24AD Migration Package).  This supports migration 
from all Meridian Mail MM11, MM12, and MM13 releases for all Meridian Mail platforms except the 
MSM and Card Option running MM13.11.2.  It is required for all Meridian Mail releases including 
MM13.14 as this tape supersedes the migration utility available in the TOOLS level.   
 
Notes:   

• Previous 1.07 versions of the migration utility NTUB24AA or NTUB24AB cannot be used with 
CallPilot 3.0.  The Migration guide should be consulted for limitations. 

• It is highly recommended the latest documentation be referenced when performing a migration.  
At the time of this printing, refer to NTP 555-7101-801 Meridian Mail to CallPilot Migration 
Utility Guide, Release 3.0, Standard 1.0, dated November 2004. 

• The Mailbox Number is a unique identifier on both the Meridian Mail and CallPilot voice mail 
systems.  If the migration utility encounters a CallPilot mailbox with the same number as a 
Meridian Mail mailbox, then the utility will overwrite the existing mailbox in order to avoid a 
duplicate.   

• CallPilot requires use of the NTRB18CA MGate card for connectivity.  Systems migrated from 
Meridian Mail must ensure only the updated MGate cards are used. 

• Unlike Meridian Mail where calls were directly routed to the main ACD-DN (queue) feeding 
Meridian Mail ports, a CDN is used to route calls to CallPilot.  It is imperative that all calls be 
routed through the CDN and not directly to the ACD-DN associated with CallPilot channels.  
See the Migration guide for details 
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7 Procedures 
 
If you are setting up a server that has been shipped from the factory it will already have the Windows 
2003 Operating System and CallPilot application software installed.  In this case you need to follow the 
instructions listed in section 7.2 “Fresh Install – CallPilot Server” in order to complete the configuration 
of the CallPilot server. 
 
If you are installing CallPilot 3.0 (03.03.06.02) from image CDs on an existing server, then you need to 
start with section 7.1 “Installing from Image CD – Disaster Recovery”.  Once you have installed the 
image of the operating system and CallPilot you then need to follow the instructions in section 7.2 
“Fresh Install – CallPilot Server” in order to complete the configuration of the CallPilot Server. 
 
For a list of default user accounts and passwords required for these steps, refer to section 5.2  
“Default Passwords” 
 
 

7.1 Installing from Image CD – Disaster Recovery 
 

7.1.1 Tower (703t) / Rackmount (1002rp) platform: 

Note:  If the server was not shipped from the factory with CallPilot 3.0 pre-installed, in order 
to automatically activate the Windows 2003 O/S, CallPilot 3.0 requires an updated BIOS on the 
1002rp and an updated BIOS and firmware on the 703t.  If the updates are not done CallPilot 
will still work, however the O/S will have to be manually updated within 30 days or the system 
will be disabled and will have to be installed from the image again. 

 
1. Disconnect the CLAN network cable. 
2. Power on the server. 
3. Insert the CallPilot 03.03.06.02 Image CD – Disk 1 that is appropriate for the platform type 

that is being recovered into the CD-ROM drive. 
4. Set the BIOS to boot from CD-ROM. 
5. When the server boots from the CD-ROM, select option 1 “Install CallPilot server image 

for 703T/1002rp, reboot…” and press <Enter>. 
6. Enter “Y” to start restoring the image when the warning is displayed that this will overwrite 

all of the data on the system 
7. You may be prompted for one or two additional CD-ROMs depending on the size and 

number of hard drives in the server. When prompted "Insert media and press Enter to 
continue", remove current CD and insert the next CD and then press <Enter>.  

8. The imaging program will automatically install a fresh image of the operating system, 
CallPilot software, plus additional 3rd party software on the server. 

9. The server will automatically reboot after the image has been applied. 
10. Remove the CD from the CD-ROM drive. 
11. The server will now start the Windows 2003 mini-setup process. During this time the server 

will automatically reboot several times as the Windows 2003 configuration is finalized. 
12. After the last reboot sequence, the message appears: "Your CallPilot server needs to be 

configured.  If you have PEPS to install, please install them now.  If you have already 
installed your PEPs, please run Config Wizard.".  
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The server is now in the same state as when it shipped from the factory.  In order to complete 
the recovery you must configure the server and then restore a system backup from tape. 

 
7.1.2 IPE (201i) platform: 

 
Note:  If the server was not shipped from the factory with CallPilot 3.0 pre-installed, 201i 
servers require a new BIOS version (6.0.3) in order for Windows 2003 to run correctly.  The 
BIOS should be upgraded before installing CallPilot 3.0 / Windows 2003 from a CallPilot 
Image CD.  Please refer to Appendix C: Updating the 201i BIOS on the procedure that should 
be followed. 

 
1. Disconnect the CLAN network cable. 
2. Power on the server. 
3. Insert the CallPilot 03.03.06.02 Image CD – Disk 1 into the CD-ROM drive. 
4. Set the BIOS to support DOS devices: 

4.1. Enter the BIOS setup program by pressing F2 at the “Press F2 to enter SETUP” 
prompt. 

4.2. Use the left/right arrows to select “Advanced”. 
4.3. Use the up/down arrows to select “Installed O/S:”. 
4.4. Use the +/- keys to change the value to “Other”. 
4.5. Press <F10>. 
4.6. Select “Yes” to confirm that the changes should be served. 
4.7. After the server reboots, enter ‘Y’ when prompted if you want to Boot ROM-DOS. 
4.8. In the ROM-DOS menu, select “1. SCSI CD-ROM” by entering 1 and pressing 

<Enter>. 
4.9. At the A:\ command prompt navigate to Z:\ and run image.bat to start the imaging 

process. 
5. When the server boots from the CD-ROM, select option 1 “Restore system images, 

reboot” and press <Enter>. 
6. Enter “Y” to start restoring the image when the warning is displayed that this will overwrite 

all of the data on the system 
7. You may be prompted for one or two additional CD-ROMs depending on the size and 

number of hard drives in the server. When prompted "Insert media and press <Enter> to 
continue", remove current CD and insert the next CD and then press Enter.  

8. The imaging program will automatically install a fresh image of the operating system, 
CallPilot software, plus additional 3rd party software on the server. 

9. Remove the CD from the CD-ROM drive. 
10. The server will automatically reboot after the image has been applied. 
11. The server will now start the Windows 2003 mini-setup process. During this time the server 

will automatically reboot several times as the Windows 2003 configuration is finalized. 
12. After the last reboot sequence, the message appears: "Your CallPilot server needs to be 

configured.  If you have PEPs to install, please install them now. If you have already 
installed your PEPs, please run Config Wizard.".  

 
The server is now in the same state as when it shipped from the factory.  In order to complete the 
recovery you must configure the server and then restore a system backup from tape. 
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7.2 Fresh Install – CallPilot Server  
 

Notes:  
• This assumes that the server was shipped from the factory (with the operating system and 

CallPilot was installed).  
• In order to prevent the spread of viruses you should not connect a server to the CLAN 

until you have anti-virus software installed. 
 

1. Power on the server.  Let the mini-setup run until you are prompted to log in to Windows 
2003. 

2. Log in to the server.  The default password for the administrator, NGenSys, NGenDist, 
and NGenDesign accounts are all set to Bvw_250!#. 

3. Install any PEPs / SUs on the server.  Reboot the server if required. 
4. Launch Internet Explorer 

Note: When you launch IE for the 1st time the “New Connection Wizard” will be 
displayed.  You can either complete the wizard or exit the wizard and re-launch Internet 
Explorer. 
Note: When you launch IE, you may also get a box that says "M/S IE Enhanced Security 
config is currently enabled on your server. This advanced level of security...reduces risk...”  
It is suggested that the security level should be lowered.  It is not recommended to check 
the box to not show the message again.  If you do so and try and access a web site off the 
server that it may be blocked by the security setting and you will get no warning only a 
blank screen 

5. Log in to CallPilot Manager and run Config Wizard to configure the server using either 
“localhost” or the default server name (CallPilot). The default admin mailbox (000000) 
password is 124578.  
Note: When the language CD is placed in the drive, the Windows message is displayed 
‘What to do with the disk’. Select ‘Take No Action’ and check the ‘Always do the selected 
action’ button and click “OK”. 

6. After running Configuration Wizard, reboot the server. 
7. Right click on the desktop ‘Network’ icon, and select ‘Properties to configure the 

appropriate configuration settings (WNS, DNS, etc.). 
8. Configure the DNS suffix following these steps: 

a. Right Click on My Computer and click Properties.  The System Properties screen 
will be appear 

b. Select the “Computer Name” tab 
c. Click on the “Change” button 

ATTENTION:  Do not change the computer name through this window.  Only 
change the computer name through CallPilot Config Wizard. 

d. Click on the “More” button 
e. Enter the Primary DNS Suffix for the CallPilot server.   

(Example: “ca.nortel.com”) 
f. Reboot the server 

9. Install anti-virus software from the antivirus application CD (not included with CallPilot or 
provided by Nortel Networks).   
NOTE: When installing anti-virus software there are specific restrictions on the 
configuration of the software to ensure that there is no impact on the CallPilot server. 
Please refer to bulletin P-2003-0151-Global “CallPilot Support for Anti-Virus 
Applications”. 
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10. Connect to the CLAN.  Download virus definition updates.   
11. Download and install latest approved security patches / critical updates from Microsoft 

using the ‘Start/Windows Update’ menu.  Refer to bulletin P-2005-0056-Global “CallPilot 
Server Security Update” 

 
 

7.3 Fresh Install / CallPilot Manager Stand-alone web server 
1. Insert the CallPilot Applications CD into the CD-ROM drive. 
2. Run the cpmgrsetup.exe application located in \CallPilotManagerInstall directory. 
3. After the installation is complete apply the workarounds listed below and then reboot the 

stand alone web server. 
 
 

7.4 Software re-install 
 

It may be desirable to re-install / uninstall / repair the installation of a component on the CallPilot 
Server without a complete re-install of the server from image.  The following software is available 
on the CallPilot Applications CD for this purpose. 
 

7.4.1 CallPilot Server Uninstall / Reinstall / Install 
 
The CallPilot Server install / reinstall / upgrade executable (setup.exe) can be found in 
\CallPilotInstall on the Applications CD.  Upgrading the CallPilot software will be completed using 
a new image set of CDs and accompanied by an upgrade and setup wizard.  DO NOT upgrade to a 
later version of CallPilot using a later Applications CD, as this will cause problems with your 
upgrade. 

 
7.4.1.1 CallPilot Server Reinstall 

 
Re-installing the CallPilot software restores the CallPilot software to its original state from the 
CallPilot Applications CD.  Currently configured data and messages will not be lost.  Another 
common term for reinstall is dummy upgrade.  A reboot is required after the reinstall. 

 
A window similar to the following will be displayed based on your version of software; 
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7.4.1.2 CallPilot server Uninstall 
 

Uninstalling the CallPilot software completely removes the CallPilot application from the CallPilot 
server, including the currently configured data and messages.  Once the install completes, a system 
reboot is required.  To uninstall the CallPilot system, execute the following; 

 
1. Start > Programs > CallPilot > Uninstall 
2. Enter Yes to the prompt. 
3. Enter Yes to the shared component prompts 
4. Once complete reboot your system 

 
During the uninstall process, the drivers for the multimedia cards (MPB) are removed.  When the 
system is rebooted, Windows detects the fact that MPB card(s) are unconfigured and the Windows 
hardware wizard executed.  It is important to press the cancel button to the wizard, otherwise a blue 
screen will occur on the system.  CallPilot Install will load the MPB drivers in their required 
locations and perform the configuration. 
 

 
 
When this screen is observed, it is imperative that the Cancel button is pressed, otherwise a blue 
screen will appear. CallPilot Install loads and configures the required drivers. 
 

7.4.1.3 CallPilot server Install 
 

Installing the CallPilot software copies a fresh copy of software from the Applications CD. The 
system must then be configured and customer data possibly restored.  If any other version of 
CallPilot is found on the system, either an upgrade or Reinstall will be performed, as displayed. 

 
A screen similar to the following will be displayed with the current version of software being 
installed. 
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Note: While re-installing the CallPilot software, you may receive a “Windows File Protection” error.  
You should choose the option to keep these unrecognized file versions (from Windows point of 
view) file. 

 
7.4.2 CallPilot Manager Uninstall / Install 

 
The CallPilot Manager install / reinstall / upgrade executable (cpmgrsetup.exe) can be found in 
\CallPilotInstall 

 
7.4.3 pcAnywhere 11.0.1 uninstall / install / reinstall 

 
Found in \PCAnywhere11.  Need to install both the package 11.0 (CallPilot Support Host 
Only.exe) and the update 11.0.1 (pca1101.exe) in order for it to work correctly.  Can run “change” 
from the control panel -> Add / Remove programs to repair an existing installation and run 
“remove” to uninstall.  Run the executable CallPilot Support Host Only.exe, follow the on screen 
instruction, and then run pca1101.exe to reinstall. Default installation directory C:\Program 
Files\Symantec 

 
7.4.4 pcAnywhere uninstall 

If pcAnywhere is uninstalled, it removes a DCOM registry value that is required for CallPilot 
Manager, My CallPilot, Application Builder, and Reporter to function correctly. 
 
Workaround: Obtain the “EnableDCOM.reg” file from the ESPL PEP Library and apply to the 
CallPilot system.  The affected applications will resume functioning normally. 
 

7.4.5 Adobe Reader 6 uninstall / install / reinstall 
 

Found in \AdobeReader6.  Can run “change” from the control panel -> Add / Remove programs 
to repair an existing installation and run “remove” to uninstall.  Run the executable 
AdbeRdr60_enu_full.exe, and follow the on screen instruction to reinstall.  Default installation 
directory C:\Program Files\Adobe\Acrobat 6.0 
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7.4.6 LSI MegaRaid 1600/3200 Power Console + (RAID admin software) 
 

This software is only applicable to the 703t and 1002rp platforms.  
 
Found in \RAID\MegaRaidPowerConsole.  Can run “change” from the control panel -> Add / 
Remove programs to repair an existing installation and run “remove” to uninstall.  Run the 
executable setup.exe, and follow the on screen instruction to reinstall.  Default installation directory 
C:\Program Files\MegaRAID 

 
7.4.7 Sun Java Run Time Environment 

 
The Sun Java run time environment version 1.3.1_11 is included for customers that want to use 
Reporter and are using the Netscape browser, or Microsoft Internet Explorer without a built in Java 
virtual machine.  Found in \Java2RunTimeEnv.  Can run “change” from the Control panel -> Add 
/ Remove programs to repair an existing installation and run “remove” to uninstall.  Run the 
executable j2re-1_3_1_11-windows-i586.exe, and follow the on screen instruction to reinstall.  
Default installation directory C:\Program Files\JavaSoft\JRE\1.3.1_11 

 
 
 

7.5 Change in location of various Windows OS-centric utilities 
 
In Windows 2003, Microsoft has relocated many OS-centric utilities that may be used for 
installation, configuration, or maintenance of the CallPilot server.  The following highlights those 
commonly used utilities and how to access them in Windows 2003 
 

• Event Viewer: Start > Programs > Administrative Tools > Event Viewer 
• Disk Management: Start > Programs > Administrative Tools > Computer Management 
• Device Manager: Start > Programs > Administrative Tools > Computer Management 
• Local Users and Groups: Start > Programs > Administrative Tools > Computer 

Management 
• Services: Start > Programs > Administrative Tools > Services 
• Computer Name: <Use Configuration Wizard>.  Do not change the computer name via 

the Operating System otherwise database inconsistencies may result. 
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8 Known Problems / Issues 
 
 
 

8.1 Server  
 

8.1.1 Server OS Activation 
If the server does not have the correct release of the BIOS / firmware, the O/S requires 
activation after the image is installed.  If the system is not activated within 30 days it will be 
blocked from logging into the Windows 2003 system if logged out.  Options at that point are 
(1) activate your system using the COA via the internet or phone, or (2) re-image your system 
for another 30 day trial period.  If after installing an image you adjust the date past the 30 day 
activation period the system will lock and you will have to activate it or install it from an image 
again.  Upgraded 703t Tower systems require product activation as part of the upgrade process. 
 
Workaround: Ensure the system has the appropriate BIOS/Firmware versions 
 
 
8.1.2  CP 201i Windows 2003 Shutdown Doesn't Work 
Unable to use reset button on 201i to boot the server. 
 
Workaround: The 201i servers power supplies were never designed to be "shut-off" by the 
OS Temperoarily remove the server from the shelf for a small amount of time (say 30 
seconds).  Upon reseeding the 201i into the shelf it will function normally." 
 
 
8.1.3 Using Wrong Image CD  
Using the wrong image CD on a server (i.e. 201i or a 1002rp) will cause unpredictable results i.e. 
the image will install but the system may not work correctly, CR Q00927821. 
 
Workaround: Only use CallPilot Image CDs that correspond to the matching platform type. 
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8.1.4 Blue Screen after updating device drivers 
Using the Windows Device Manager to update or uninstall the MPB drivers will cause a blue 
screen. 
 

 
 
Workaround: Cancel out of the Windows Device Manager if MPB16-4 or MPB96 media cards 
are found as new hardware, DO NOT PRESS NEXT.  Only use documented NTP procedures 
for updating any device drivers. 
 
8.1.5 Unable to restore archive from earlier TRIAL release 
User archives from previous releases (03.01.04.00 or older) can not be restored on this release.  
User data structures were changed to prevent potential data corruptions.  Currently, Backup 
and Restore does not have a version associated with each archive or backup.  Therefore, if a 
user archive from previous release is selected to restore, Backup and Restore will attempt to 
restore and report the restore operation fail. 
 
8.1.6 Unable to change password via Configuration Wizard 
When the "Finish" button is clicked, at the last page in Configuration Wizard dialog, the server 
is updated with all new information provided by user.  During this phase, the Configuration 
Wizard will try to update the password, but could fail, due to the Windows 2003 security policy 
("Minimum Password Age") if the policy value is set to a value greater than zero (0). 
 
Workaround: Adjust the Windows 2003 security policy for Minimum Password Age to zero 
(0).  This will alter the security policy for this server, so recommend coordinating with the 
system administrator first. 
 
8.1.7 “No Dongle Found” error after installation 
Very intermittently, you may receive a “No Dongle Found” error after installing a 201i server. 
 
Workaround: Reboot the server. 
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8.1.8  “RDP Protocol Component – Data Encryption” error 
When trying to connect to a 201i from a desktop using Microsoft Remote Desktop, the 
following error “The RDP Protocol component “DATA ENCRYPTION” detected an error in 
the protocol stream and has disconnected the client.” may occur which may block connecting 
to the server.   
 
Workaround:   Refer to Microsoft Knowledge Base article KB323497 at the following URL 
http://www.support.microsoft.com/?kbid=323497

 
8.1.9 Taskbar Menu pops up or MAS window appears in center of screen 
Whenever the MAS window or any console window is minimized, the Taskbar Menu pops up 
as indicated (see below).  Additionally, sometimes closing the Taskbar Menu results in the MAS 
window appearing in the center of the screen again.  This behavior is primarily observed when 
using pcAnywhere.  Refer to CR # Q00947757 ( closed). 
 

 
 

8.1.10 Windows Task Bar appears to be missing 
When the system is first powered up following a new install, the mini-setup will run for a period 
of time and then reboot.  Once the system reboot has completed, you will be able to log into 
the system using one of the CallPilot Windows usernames.  Once logged in, the Windows 
taskbar may appear to be missing but is only hidden at the bottom of the console window.  
Refer to CR # Q01008560 (closed). 
 
Workaround:  To make the taskbar visible, use your mouse pointer and left mouse button to 
grab the task bar and pull it up to the desired height. 
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8.1.11 List Tape function is too slow 
When using the CallPilot Backup and Restore tool, List Tape function may take a long time to 
respond.  This may occur if the tape was not re-tensioned or rewound after a full system backup 
was completed and the tape left in the drive. 
 
Workaround:  Remove the tape from the tape drive and re-insert.  This will rewind the tape to 

the beginning. 
 
8.1.12 Remote Disk backup to network share takes excessively long time 
When performing remote disk backups to a network share, if the LAN configuration is invalid, 
the backup may still complete successfully, but may take a longer period of time. 
 
Workaround:  To ensure the NIC is configured appropriately, use the following steps: 

1. Click Start > Settings > Network Connections 
2. Right-click on the NIC Card and click on Properties. The CLAN (or ELAN) 

Properties screen will appear. 
3. Click on the Configure... Button. The Network Connection screen will appear. 
4. Select the Advance Tab 
5. For 703t and 1002rp: 

a. Highlight Link Speed and Duplex then select the required setting from the 
Value Drop-down Box on the right. Default value is Auto-Detect. 

6. For 201i: 
a. Highlight Duplex then select the required setting from the Value Drop-

down Box on the right.  Default value is Auto-Detect. 
b. Highlight Speed then select the required setting from the Value Drop-

down Box on the right.  Default value is Auto-Detect.  
 

8.1.13 Unable to log into Windows 
Sites using a non-North American (US) keyboard, may encounter issues when initialing 
attempting to log into the server entering strong passwords.  This is the result of all CallPilot 
images being configured to use a US-keyboard layout by default.  To overcome this, use the 
workaround listed below.  Refer to CR # Q01023414 (closed). 
 
Workaround:  To overcome initial login issues with keyboard layout, enter the password using 
keystrokes similar to a US-keyboard.  For example, when entering “Bvw_250!#”, use shift-3 to 
indicate the “#” character. 
 
To avoid any other keyboard layout issues, use the following steps: 

1. Launch the "Regional and Language Options" applet from the Control Panel  
a. (Start Menu > Settings > Control Panel > Regional and Language Options). 

2. In the "Regional and Language Options" dialog, change to the Languages tab. 
3. Click on the Details button. 
4. In the "Text Services and Input Languages" dialog, click on the Add button. 
5. In the "Add Input Language" dialog, select the appropriate keyboard layout and/or 

input language, and then click on the OK button. 
6. In the "Text Services and Input Languages" dialog, change the default input language 

to the newly added language, then click on the OK button. 
7. In the "Regional and Language Options" dialog, then click on the OK to exit. 
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8.1.14 CallPilot server freezes after a restart 
Very intermittently, the CallPilot server may freeze after initiating a restart using  
<Ctrl-Alt-Del>.  Refer to CR # Q01018679 (closed). 
 
Workaround:  If this condition occurs, rebooting the server a second time will clear the 
condition.  A PEP is available for CallPilot 3.0 GA, CP300S00G11S  

 
8.1.15 RAS connection to server unstable and drops 
When the client makes a connection to a CallPilot server through a modem and RRAS, the 
connection appears unstable and finally drops.  The connection is negotiated, modem to 
modem, then RRAS on the server side assigns temporary IP addresses to both the client and 
the server.  From the client, when the server is ping’d using the assigned IP address (typically 
192.168.0.1), mostly timeouts occur but some packets are successful.  After a short period of 
time, the connection may drop.  Impacted are any remote applications including Microsoft 
RDC, pcAnywhere, CallPilot Manager, Application Builder, etc.  Refer to CR # Q01070343 
(closed). 
 
Workaround:  The problem described above may occur if two (2) modem devices are 
configured for COM1, the one that was actually connected (US Robotics 33.6 FAX Ext. PnP) 
and one not connected to the system, in CallPilot’s case the Standard 33600 Modem.  Because 
of this, it instability is caused by the incorrect driver being used for the US Robotics modem.  
 
To verify if two devices are connected to COM1, look into the Routing and Remote Access 
application (Start > Programs > Administrative Tools > Routing and Remote Access). Under 
Server Status there should only be one (1) total port.  In the case of this failure, there may be 
two (2) or more. 
 

 
 
Under Ports, select the modem and then Status. There should be only one device listed in the 
drop down list box (U.S. Robotics 56K FAX EXT (COM1), but in this case there was also the 
Standard 33600 modem.  
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The only method of removing the incorrect modem (e.g. Standard 33600 modem) from RRAS 
is to remove it from the system.   
 
The method used is to remove all modems from the system under Windows Device Manager, 
and then scan for new devices with only the correct modem connected to COM1.  The 
Standard 33600 modem was now removed from the system, RRAS only contained the U.S. 
Robotics 56K FAX modem and automatically finds the correct driver. 

 
8.1.16 ELAN Disables After RDC Connection Over RRAS IP Address 
When using Remote Desktop Connection (RDC) to connect to a Windows Server 2003 based 
CallPilot server via a dial-up RRAS( Routing and Remote Access service ), a frozen screen 
might be observed and CallPilot going out  of service for a couple of minutes. 
 
Workaround: At the time of this printing, Microsoft is working on a fix. It is recommended 
to use a high-speed connection when using RDC via RRAS.  
 
 
 

 
8.1.17 SLEE Trace Facility Causing 38003 Event and Possible Outage 
The application event log gets flooded by minor 38003 events from Resource Package with the 
following description:  
"An unexpected Windows message was received [Message = XXXXX, TID=YYYY]". 
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They are generated at rate of more than a dozen of events per second. Though, it seems to 
bring no obvious negative impact, such unusual activity can potentially result in performance 
degradation. CR # Q01428821. 
 
Workaround: 
You can still use the SLEE trace utility safely using the following rules: 

1. Leave the tool running after you are done, just stop tracing (pencil button); 

2. Reboot the CallPilot to close the tool safely during a maintenance window 
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8.2 CallPilot Manager 
 

8.2.1 Unable to log into CallPilot Manager due to unknown password 
Access to CallPilot Manager requires the user to have an Administration account/password. 
If the default Administration Password (mailbox “000000”, password “124578”) has been 
changed and forgotten or misplaced, a utility exists with CallPilot 3.0 for resetting it to the 
default. 
 
Workaround: Use the following procedure to reset the default administrator password. 

1. Log in to "Distributor" Support Tools on the CallPilot Server 
 Start → Programs → CallPilot → System Utilities → Support Tools 
2. From the main menu, select (9) Database Utilities 
3. From the Database Utilities menu, select (3) Database API Utility 
4. At the CI> prompt, type “resetadminpwd” and press <Enter> 
5. At the CI> prompt, type “quit”.  This will close the API Utility 
6. In the main menu, press <Enter>, then select (1) to exit. 

 
  The default Administration mailbox “000000” password will be reset to “124578” 
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8.3 Event Monitor/Viewer 
 

8.3.1 Events 2, 3, 4, 8, and 9 appear in System Event logs 
When accessing the CallPilot server via a Remote Desktop, Events 2, 3, 4, 8, and 9 may appear 
in the System Event log.  These events reference LAN printers even though no print action was 
performed by the user.  Refer to CR # Q00943668. 
 
Workaround: Discontinue using Remote Desktop or simply disregard the events.  They have 
no known impact to CallPilot. 
 

 
 

 
 

 
 
 

8.4 Alternate User Interface 
 

8.4.1 Menu User interface users unable to log in 
Menu User Interface requires the mailbox length match that as configured in Messaging 
Management.  If the mailbox length doesn’t match what is configured, the user will be unable to 
log in from their telset.  Refer to CR # Q01041115 (closed). 
 
Workaround: Ensure all mailboxes that will utilize AUI services are configured with a mailbox 
DN length that corresponds to the length as configured in Messaging Management / General 
“Length of mailbox number”. 
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9 PEP/Service Update application overview 
 
Performance Enhancement Packages (PEPs) and Service Updates (SUs) are software fixes or updates 
that enhance CallPilot features and operation.  CallPilot PEPs generally deliver individual fixes while 
Service Updates contain more comprehensive updates.  As PEPs/SUs are delivered periodically, it’s 
recommended the Meridian Enterprise Solutions PEP Library (ESPL) website be checked regularly to 
ensure the latest updates are applied. 
 
The most recent PEPs for CallPilot 3.0 can be found on the Nortel Networks Enterprise Solutions PEP 
Library (ESPL) website at: http://www.nortelnetworks.com/espl (all regions) 
 
Note:  If you are new to the ESPL website, you will need to register for a user ID/password.  Please 
apply on-line at http://www.nortelnetworks.com or contact your local Nortel Networks Channel 
Partner Account Manager. 
 
 

9.1 PEP Numbering Format 
 
 
The PEP numbering format for server PEPs includes supplemental information for which Service 
Update they apply to using format: CPRRRSSSXYYZ:   
 
 Where: 

 RRR: Software Release (eg. 3.00, 2.02, 2.50)  
SSS: The required SU level required to apply the PEP  

Example: (S01 = Service Update 01) 
X: The type of PEP:  

(G)eneral, (R)estricted, (L)imited, or (D)iagnostic. 
 YY: The PEP number (1-99). 

Z: The component that is being PEPed / updated: 
(S)erver, (C)allPilot Manager, (A)pplication Builder, (M)y CallPilot, or 
(D)esktop client. 

 
The CallPilot server is the only component that will have small PEPs.  Other components may have 
PEPs released, but the PEP will really contain an updated version of the software package.  The 
following list summarizes the different components and how they are PEPed: 
 
 CallPilot Server: PEPS 
 CallPilot Manager: Software update 
 Reporter:  Packaged as part of CallPilot Manager software update 
 My CallPilot:  Software update 
 Desktop:  Software update 
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9.2 CallPilot SU/PEPs 

 
At the time of this printing, Service Update 2 is available for download. CallPilot Service Update 1 is 
obsolete by CallPilot Service Update 2. For future reference, this section covers all Service Updates and  
PEPs with CR details. 

 
9.2.1 Service Update CP30306SU01S 

 
 

PEP number Description 

CP30306SU01S 
Service Update 1 (SU01) which also installs the following General Available 
PEPs: CP303S01G05S, CP303S01G09S, CP303S01G10S, CP303S01G11S 
and Limited PEP (platform dependent) CP303S01L12S. 

 
CallPilot 3.0 Service Update 1 replaces the following PEPs. The replaced PEPs will be automatically 
uninstalled when installing CP30306SU01S. 
 

• CP300S00G09S 
• CP300S00G11S 
• CP300S00G15S  
• CP300S00G17S 
• CP300S00G19S 
• CP300S00G20S 
• CP300S00G21S 
• CP300S00G23S 

 
 
 
 
 

9.2.2 CallPilot Service Update 1 Individual PEPs 
 
 

PEP number Description 
  

CP404S01G08A Application Builder client (04.04.04.02) – Recommended to be used with 
CallPilot 3.0 

CP300S00G01A Application Builder client (03.03.06.02) for use with CallPilot 3.0 and 
2.02/SU03 and later servers 

 

CP404S01G11C CallPilot Manager(04.04.04.03) – Recommended to be used with CallPilot 
3.0  

CP300S00G10C CallPilot Manager (03.03.06.03) – Required for use with CallPilot 3.0 
  

CP303S01G05S SCCS-CP integration - phantom calls on CallPilot side. 
CP303S01G09S IMAP service crashes frequently with event 41505/All calls have digitized or 
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Garbled Voice 
CP303S01G10S Minimum channels for CallPilot SDN is not working properly  
CP303S01G11S CallPilot is experiencing ring no answer when making changes in DB values 

  
CP303S01L06S One Number Voice/Fax Call Answering feature 
CP300S01L12S  Deeply nested Appbuilder Applications causing ring and drop scenario 
CP300S01R04S Multi-part thru-dial and incorrect greeting update. 

  
CP303SEC003S Server Security Update w/ Microsoft hotfixes up to MS05-053.  
CP303SECSP1S  Service Pack 1 for Windows Server 2003 

 
 

Note: For details on approved Microsoft security updates, refer to Product Bulletin P-2005-
0056-Global “CallPilot Server Security Update” for details. 
 
 

9.2.3 Service Update CP30306SU01S Content 
 
The following fixes and enhancements are addressed with CP30306SU01S: 
 

CR Title 
Q00681013 Intermittent failure of transfer to DN when using CallPilot treatment with SCCS 
Q00708444 System Monitor tool does not show the PEPs installed on the system 
Q00776665 LDAP leaking Memory 
Q00840397 Restore CallPilot from FSB skips the file "D:\Nortel\Data\schemamap" 
Q00859634 During 40 channel load test due to play problem in MAS resources SLEE crashes 
Q00888949 System becomes inoperative after restore of backup with different version 
Q00901042 Voice Item Maintenance fails to record for the full allotted time 
Q00902745 Several warning events 40254 in application logs 
Q00918163 Annoying event 58534 is seen in the Windows NT Application Event log 
Q00922396 SLEE is receiving incorrect data from TAPI on session init. Phantom call events 
Q00930687 Pegging problem: Excessive Incomplete Messaging Accesses Alert Report 
Q00931356 AML Trace Enhancements 
Q00933261 ELAN Issues Preventing CallPilot to Boot 
Q00937327 Notification server consumes more than 90% CPU 
Q00939071 Migrate.exe version 3.2.1.0 Application error version 3.2.1.0 EVENT 1000 
Q00942091 TSP memory corruption causing call processing outage 
Q00954025 Messages deleted from telset are still there in 2nd login 
Q00955276 Events 36027, 36033 should be modified 
Q00959365 Getting ring no answer on Multimedia ports with SCCS integration 
Q00959966 Events 55045 and 55046 added into Fault Manager 
Q00966310 Can not login to Desktop Messaging when password due to expire 
Q00972736 RNA after upgrade to 2.02:too many SDN entries 
Q00977032 Event descriptions should be updated in the CallPilot Manager 
Q00982422 AppBuilder Applications inaccessible and unavailable after SU03 was applied 
Q00987148 IVR channels are not correctly displayed in Channel Monitor 
Q00988007 Network wide broadcast messages fails to be delivered 
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Q00991166 IMA service is consuming 100% CPU usage 
Q00996757 Infinite loop in Version Manager because of data corruption 
Q00999036 Unable to open locked applications 
Q01002510 Memory error appears after CallPilot server reboot 
Q01010963 With 2 authentication methods and SSL enabled, a VPIM message can't be sent out 
Q01017361 Cannot use the Remote Disk Backup to Subfolders 
Q01018679 CallPilot server freezes after a restart (Ctrl Alt & Delete) 
Q01023311 CallPilot RNA. System Monitor shows both DSPs and DSOs Idle 
Q01039276 OM data collection turning off intermittently and requires a reboot to start 
Q01039807 Problem with backups, Database is being skipped 
Q01046083 System backup failed but the status said it was completed successfully 
Q01057676 Application Builder ring once and drop 
Q01058368 CallPilot RNA with TSP events 42803 
Q01059475 AppBuilder Data Integrity & deletion tool (appdelete) goes into indefinite loop 
Q01068557 Modifications to LDAP for Email account administration 
Q01074485 RNA with Fatal Exception 42803 worktype 17 
Q01087961 One ring and drop on all applications 
Q01090487 Messaging Management page is damaged if user has some changes on it 
Q01101119 CallPilot Servers connected to same Reporter server had RNA 
Q01116404 Install PEPs and SUs without stopping Windows and CallPilot services 
Q01119325 Database API tool allows distributor to obtain FULL access to database 
Q01127749 CallPilot messages Telset Time stamp 1 hour out for New Zealand prior to daylight 

saving 
Q01144219 Trace viewer utility from Support Tools is shutting down 
Q01149295 MeridianMail to CallPilot migration: the COS record could not be created, RC 

[60638] 
Q01152586 System disconnects when user dials to VIM SDN 
Q01154562 GIVE CONTROLLED BROADCAST Fails Intermittently - RNA / Delayed 

Answering 
Q01161352 CallPilot Server security was compromised through FTP Service 
Q01161943 ACCESS channels in PBX go MSB LOG OUT when CallPilot reboots 
 

 
9.2.4 Service Update CP30306SU02S 

 
 

PEP number Description 

CP30306SU02S CallPilot 3.0 Service Update 2 (SU02) which also installs the following 
individual PEPs: CP303S02G01S and CP303S02L04S. 

 
Note: 
1. PEP CP30306SU02S installs Service Update 2 and the following PEPs: 

 
• Target platform - 201i: 

 - CP30306SU02S 
 - CP303S02G01S 
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• Target platforms - 703t, 1002rp: 
 - CP30306SU02S 
 - CP303S02G01S 
 - CP303S02L04S 

 
2. The PEP replaces the following PEPs. The replaced PEPs will be automatically uninstalled 

when installing CP30306SU02S.  
 

- CP30306SU01S 
- CP303S01G05S 
- CP303S01G08S 
- CP303S01G09S 
- CP303S01G10S 
- CP303S01G11S 
- CP303S01G14S 
- CP303S01G15S 

 
 
 

9.2.5 CallPilot Service Update 2 Individual PEPs 
 
 

PEP number Description 
  

CP404S02G05A Application Builder client (04.04.04.04) – Recommended to be used with 
CallPilot 3.0 

CP404S02G08C CallPilot Manager(04.04.04.12) – Recommended to be used with CallPilot 
3.0  

CP303S02G01S Calls RNA/Event ID 1 SQLany Fatal Error Memory Exhausted 
CP303S02L04S Server outage when saving application 
CP303SEC003S Server Security Update w/ Microsoft hotfixes up to MS05-053.  
CP303SECSP1S  Service Pack 1 for Windows Server 2003 

 
 
9.2.6 Service Update CP30306SU02S Content 
The following fixes and enhancements are addressed with CP30306SU02S: 
 

CR  Title 
Q00492049 Daylight Savings time switches at wrong time for Satellite users in different TZ 
Q00858851 CallPilot doesn't drop/release DSP if not recording any command during training 
Q00869407 User mailbox with User admin right could not view/open other mailbox 
Q01011396 SCCS-CP integration - a lot of phantom calls on CallPilot site 
Q01076995 Discrepancy between the number of mailboxes on the server and Reporter 
Q01125942 T1 Remote Notification Disabling Itself after SU02 install 
Q01146189 Incorrect Time stamp on Email by Phone 
Q01153542 Events 38007, 58207, & 55213 cause RNA 
Q01159874 Database skipped during restore of system backup - restore log needs enhancement
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Q01183067 Unable to deliver fax to more than 29 recipients using DTF Feature 
Q01183921 CP is experiencing ring no answer when we make changes in DB values 
Q01190522 Logging into CDN After Receiving RN to Telephone Not Playing AUI 
Q01211286 IMAP service crashes frequently with event 41505 rc=243 
Q01213280 AUI: Incorrect RPL is used for thru-dialing after login 
Q01214250 Outbound fax stops working with IMA crash 
Q01218326 RNA - ALL DSPs active - All DSOs idle except for one 
Q01241448 "EVT41505 NMAOS" 
Q01241548 All calls have digitized or Garbaled Voice 
Q01274618 Remote text notification intermittently fails sending to blackberry 
Q01303303 Reporter shows all zero's OM not collecting on the Blue database 
Q01307621 Calls RNA/Event ID 1 SQLany Fatal Error Memory Exhausted 
Q01332316 OM Server: Event 41052 needs to be added 
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10 Documentation References 
 
The following table provides a list of supplemental documentation, available at the time of this printing, 
which may be useful in support of CallPilot 3.0 servers. 
 
These documents are available on the following web sites: 
 
Nortel support:    http://www.nortel.com/support
Partner Information Center (PIC): http://my.nortel.com
 
Document/Bulletin 
Type 

Document Number Description 

Product 99067 CallPilot Unauthorized Hardware and Software 
Product P-2005-0243-Global CallPilot Spares Planning 
Product P-2003-0151-Global CallPilot Support for Anti-Virus Applications 

Product P-2005-0026-Global CallPilot 3.0 and 201i IPE Platform –  
Using Microsoft Remote Desktop Connection 

Product P-2005-0038-Global CallPilot 1002rp Rackmount Status Update 
Product  P-2005-0167 -NA CallPilot Sever-Level Replacment Procedures 

Product  P-2005-0173-Global CallPilot: LSI Logic MegaRAID SCSI 320-2 Hardware 
Introduction 

Product P-2006-0011-Global CallPilot Server Security Update 
Product  P-2005-0167 -NA CallPilot Sever-Level Replacment Procedures 
Product  P-2006-0103-Global CallPilot 703t Tower Server Availability 

Product  P-2006-0256-Global CallPilot Support for Additional Windows Server 2003 
Editions 

Product P-2006-0288-Global Multimedia Applications Products – Interim Compatibility 
Advisory for Microsoft Internet Explorer Release 7.0  

Product  P-2006-0329-Global CallPilot Tower/Rackmount Platform Disk Drive 
Updates 

Retirement  R 2006-0240 Meridian Mail Message Service Module (MSM) End of 
Life Date Change 

Sales/Marketing SM-2002-1578-NA Meridian Mail to CallPilot Investment Protection Offer 
Sales/Marketing SM-2004-0379-NA Meridian Mail Investment Protection Offer Expiration 

Sales/Marketing SM-2004-0416-
Americas CallPilot 3.0 Channel Readiness Activities 

Sales/Marketing SM-2004-0487-
Americas-Rev 2 CallPilot 3.0 GA for Tower and Rackmount Platforms 

Sales/Marketing SM-2005-0043-
Americas CallPilot 3.0 GA on 201i IPE Platform 
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Appendix A: CallPilot/SCCS/CCMSIntegration 

CallPilot 3.0 / Symposium Call Center Server 4.2 Integration checklist 
The following items should be reviewed to ensure proper integration between Symposium Call Center 
Server 4.2 and CallPilot 3.0 for Voice Services.   
 
Software pre-requisites: 

1. SCCS 4.2 with PEP NS040206SU07S or later 
2. CallPilot 3.0 (03.03.06.02) 
3. Minimum Meridian 1 X11 (25.40) or Communication Server 1000/1000M/1000E (release 3.0) 

or later with the following software packages: 
 

 CallPilot SCCS 
Pkg Description X11 X21 X11 X21 
35 IMS – Integrated Message Service *  * * 
40 Basic Automatic Call Distribution *  * * 
41 ACDB (ACD Package B) * * * * 
42 ACDC (ACD Package C)   * * 
43 LMAN – ACD Load Mgt Reports   * * 
45 ACDA (ACD Package A) *  * * 
46 MWC – Message Waiting Center * *   
50 ACDD (ACD Package D)   * * 
77 CSL – Command Status Link * * * * 
83 CDRQ – ACD CDR Queue Record *    
98 DNIS – Dialed Number Identification Service opt    
111 TOF – ACD Timed Overflow Queuing *    
114 AUXS – ACD Pkg D, Aux Security   * * 
153 X25AP – Application Module Link – AML * * * * 
155 ACDNT – ACD Account Code   * * 
164 LAPW – Limited Access to Overlays * *   
175 NMS – Network Message Service opt opt   
209 MLM – Meridian Link Modular Server   * * 
214 EAR – Enhanced ACD Routing * * * * 
215 ECT – Enhanced Call Treatment * * * * 
218 IVR – Hold in Queue for IVR * * * * 
242 MULI – Multi-User Login * *   
243 Alarm Filtering * *   
247 Call-ID (for AML Applications) * * * * 
254 Phantom TN * *   
296 MAT – Meridian Administration Tool * *   
311 NGCC – Nortel Symposium Call Center   * * 
324 NGen (MAS Connectivity) * * * * 
364 NMCE (CallPilot) * *   
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Documentation available: 

1. NTP 555-7101-222: CallPilot 3.0 Installation and Configuration Guide, Part-3 Meridian 1 and 
CallPilot Server Configuration Guide 

2. NTP 555-7101-510: CallPilot 3.0 Installation and Configuration Guide, Part-3 Succession 1000 
and CallPilot Service Configuration Guide 

3. NTP 555-7101-801: Meridian Mail to CallPilot Migration Utility Guide (if migrating voice 
prompts) (Standard 2.0, dated May-2004 is latest) 

4. Symposium, M1/CSE1000 Voice Processing Guide 
 
Note: The Partner Information Center / Helmsman Express documentation website contains the above 
documents.  Ensure the latest versions are utilized when integrating both solutions. 

• For CallPilot documentation, from the main product screen, select “Meridian 1 and 
Communication Server 1000 Systems” and under Applications select “CallPilot Release 3.0 
(CallPilot_30). 

• For Symposium documentation, from the main product screen, select “Symposium” and under 
Applications select “Symposium Call Center Server Release 4.2 CPI”. 

   
PBX configuration guidelines: 

1. VAS/SECU setting for both CallPilot and SCCS ELAN/VAS-ID should YES 
2. CallPilot agents segregated for SCCS support should be build w/ Class of Service: 

CLS-MMA and AST 
 
Additional general notes: 

1. Recording Voice Prompts using telephone set requires Desktop Messaging License 
The recording of Voice Prompts using a telephone set on CallPilot currently requires the 
Desktop Messaging application to be installed with appropriate licensing.  Customers requiring 
this capability and not having Desktop Messaging should contact their Nortel Networks prime 
to resolve this issue. 

 
2. Calls receiving GIVE IVR ring indefinitely when CallPilot Server out of service 

SCCS will attempt to perform the GIVE IVR operation if specified in the scripts even if the 
CallPilot Server with the voice ports for IVR processing is powered down.  In this case, calls 
will hear ringing but will not be provided voice services and will not advance in the SCCS script.  
Refer to CR # Q00503343 and Q00465763. 
 
Customers should ensure that the scripts are modified not to provide voice services if the 
CallPilot Server is out of service.  An alternative solution is to manually log out the voice ports 
on the switch if the CallPilot server is shut down. 
 
Workaround:  During shutdown of the CallPilot server, to ensure the proper MLINK 
messages are sent from CallPilot to SCCS and that voice services channels are properly logged 
out; ensure Meridian 1/Communication Server 1000 Release 1.1 PEP MPLR16351 has been 
applied. 

 
3. Stop/Start of voice channels on CallPilot requires action on SCCS 

If voice channels are stopped and re-started using CallPilot Manager (through Channel Monitor 
or Maintenance Admin), they will not resume voice processing until they have been de-acquired 
and re-acquired through the SCCS Client. 
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Customers should avoid stopping and starting the voice channels.  If this action is necessary, 
the voice ports should be de-acquired and re-acquired through the SCCS Client Voice Ports 
window. 
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4. GIVE CONTROLLED BROADCAST fails, returning only silence 
The Give Controlled Broadcast script command does not currently operate properly when the 
CallPilot 2.02 and SCCS 4.2 systems are installed on the Communication Server 1000 switch 
running Release 2.02 or some Meridian 1 systems using Superloops.  Callers will hear silence 
rather than the specified voice segment if this script command is employed.   
 
Workaround:  To resolve this issue, install the appropriate PBX PEP.  For Meridian 1 systems, 
install PEP MPLR17006. 
 

5. ACCESS channels remain in an un-initialized state if CallPilot reboots before SCCS 
MLink service is started. 

 
If the MLINK service is not up prior to the CallPilot system completing its initialization, the 
ACCESS channels will be put into an un-initialized state.  Without manual intervention, the 
access channels will remain in an un-initialized state.  From lab tests, SCCS takes approximately 
four (4) minutes to bring up the MLink service. 
 
Workaround:  Defer the boot start time on CallPilot for five (5) minutes after SCCS starts its 
boot sequence.  This can be done through the WinNT Operating System setting: 
 
On the CallPilot server, from Control Panel → System → Startup/Shutdown.  In “System 
Startup” set “Show list for” to 300 seconds.  This will delay the CallPilot boot-up for five (5) 
minutes, giving SCCS time to boot first. 
 
What works with the workaround (5 minute delay to boot start of CallPilot): 

With both systems powered down (SCCS and CallPilot): 
a. Both CallPilot and SCCS can be powered up at the same time 
b. Both CallPilot and SCCS can survive an unattended power outage, assuming that both 

systems are attached to the same power source. 
 

What does not work with the workaround: 
a. During the first power-up of CallPilot, the workaround will not be applied.  Therefore, 

cannot power up SCCS and CallPilot at the same time, for the first time. 
b. With a functional network (SCCS, CallPilot, and Meridian 1 / CS 1000) 
c. CallPilot rebooting in a 3-5 minute window prior to the SCCS rebooting.   

 
6. Migrating voice prompts from Meridian Mail requires additional steps 

When migrating SCCS voice prompts, ensure the additional steps as outlined in NTP 555-7001-
801 Meridian Mail to CallPilot Migration Utility Guide are completed prior to attempting to use 
those prompts within SCCS scripts. 
 

7.  Migrating duplicate names for Access voice segments 
When migrating voice segments using SCCSPromptsOnly option, ensure there is no duplicate 
name for ACCESS voice segments in Meridian Mail. Duplicate ACCESS voice segment will halt 
the migration process on CallPilot, CR Q01136955 fixed in CP 4.0 release. 

 
Workaround: To reconnect to Meridian Mail and change the voice segments names to unique 

names and proceed with migration. 
 
8. SCCS requires VOICE channels for integration 
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While CallPilot offers three channel types (Voice, Fax, and Speech Recognition), SCCS and 
CallPilot require dedicated voice channels for integration.  As Voice channels utilize only a 
single MPU per channel, use of Voice channels is the most cost-effective resource, similar to 
that of the Meridian Mail “BASIC” and “FULL” service channels.   
 
To avoid conditions where no voice is presented, and to ensure the integration utilizes the most 
cost-effective resources, ensure that all channels that are to be used for SCCS voice services are 
dedicated voice channels. 

9. SCCS unable to acquire resources after improper shutdown/crash. 
Symposium Call Center Service (SCCS) acquires devices such as TNs and ACD agent phone-
sets on the Meridian 1/Communication Server 1000/1000M/1000E.  If the server crashes or is 
shutdown without running the shutdown utility, these devices will remain acquired.  This can 
cause a number of problems including: 

10. SCCS 

1. If the SCCS has a problem such that it cannot de-acquire one or more devices, then 
these devices cannot be used by other applications until a switch SYSLOAD is 
performed. 

2. After the switch INIT, CDN count might be corrupted for an application link. 

In these (and possibly other) occasions, it is required to forcibly de-acquire resources 
from the Meridian 1/Communication Server 1000/1000M/1000E.  Some commands 
have been developed as tools to perform these tasks, such as: 

• De-acquire all acquired devices of application over a specified ELAN link 
• De-acquire an acquired Agent TN 
• De-acquire an acquired Route of a Customer 
• De-acquire an acquired CDN 
• De-acquire an acquired ACDDN. 

 
The commands to de-acquire each of the resources are: 

 From Overlay 48 (LD 48): 
1. De-acquire an acquired "AGENT": 

DACR AGT <Loop> <Shelf> <Card> <Unit><CR> 
2. De-acquire an acquired "ROUTE": 

DACR RTE <Route#> <Customer#><CR> 
3. De-acquire "ALL" acquired devices on a specified link: 

DACR ALL <Link#><CR> 
 

 From Overlay 23 (LD 23): 
4. De-acquire an acquired "CDN”: 

REQ  <DACR> 
TYPE <CDN> 
CUST <Customer#> 
CDN  <XXXX> 

5. De-acquire an acquired "ACDDN": 
REQ  <DACR> 
TYPE <ACD> 
CUST <Customer#> 
ACDN <XXXX> 
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You can use overlays such as 10, 11, 20, 21, or 23 to confirm the action is carried out 
successfully on your device. 

SCCS 5.0 SU05 IVR ports do not come into service with CallPilot/SCCS integration 
IVR ports will not come into service ie. will not go idle on systems with CallPilot/SCCS Integration 
when Host Enhanced Routing (HER) is disabled.  CallPilot can not correctly process the Application 
Registration Response message from SCCS with the Cause x78 IE. Subsequently, the IVR ports 
would not come into service. 
 
Workaround  
A designer patch has been created with this fix on top of 0505. The DP number is 
NN_SCCS_5.0_DP_050501_S. Please contact your first level support to obtain the designer patch. 
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Appendix B: RRAS configuration 
The following appendix is for configuring and adding users to Routing and Remote Access (RRAS). 

Note: CallPilot (build 03.03.06.02) now includes the RRAS configuration and the following steps are no 
longer required.  The information below is for reference purposes only. 
 
Enable RRAS: 
 
1. Launch the Routing and Remote Access (RRAS) manager:  

(Start -> Administrative Tools -> Routing and Remote Access). 
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2. Select the server, right click and select “Configure and Enable Routing and Remote Access” from 
the context sensitive menu. 

 

 
 

3. The RRAS setup wizard will launch. Click on Next to begin the configuration. 
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4. Select “Remote access (dial-up or VPN), and click Next. 
 

 
 

5. Select Dial-up and click Next. 
 

 
 

 
Nortel – Document # P1002957  Page 60 of 105 



6. Select remote clients that should be assigned to the network connection with the name CLAN and 
click Next. 
 

 
 

7. Select to assign IP addresses from a specified range and click Next. 
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8. Add a new range from 192.168.0.0 to 192.168.0.9, and then click Next. 
 

 
 

9. Select that connection requests should be authenticated locally (do not use a RADIUS server, and 
click Next. 
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10. Click OK to continue. 
 

 
 
11. Click on Finish to apply the configuration. 

 

 
 

12. Wait while RRAS is configured. 
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13. Once the configuration is complete the RRAS manager will be updated to reflect the changes that 
have been made. 
 

 
 

Update RRAS configuration: 
 

14. Select the server, right click and select properties. 
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15. Change to the IP tab, de-select the “Enable IP routing” and “Allow IP-based remote access and 
demand-dial connections”, and then click on OK to close the dialog. 
 

 
 

16. Select the Ports item, right click and select properties from the drop down menu. 
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17. By default there are more ports enable than are desired.  Select the “WAN Miniport (PPPOE)” item 
and click Configure. 
 

 
 

18. Deselect the demand-dial routing connections option is disabled and click OK. 
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19. Select the WAN Miniport (PPTP) option and click configure.  
 

20. Ensure that both the Remote access connections, and demand-dial routing connections options are 
de-selected and click OK. 
 

 
 

21. Select the WAN Miniport (L2TP) option and click Configure. 
 

22. Ensure that both the Remote access connections, and demand-dial routing connections options are 
de-selected and click OK. 
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23. Once all of the changes are complete only the external modem should show that is in use. Click on 
OK to exit the ports properties page. 
 

 
 

24. Exit the RRAS configuration manager. 
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Configure Users for RRAS: 
 
25. Launch the computer management tool:  

(Start -> Administrative Tools -> Computer Management), and select the local user’s folder. 
 

 
 

26. Double-click on the NGenSys user to display the user properties.  Select the “Dial-in” tab, select 
the “Allow access” option and then click on OK. 
 

 
 

27. Repeat step 18 for the NGenDesign and NGenDist users. 
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Appendix C: Updating the 201i BIOS 
CallPilot 201i IPE servers running release 3.0 (03.03.06.02) require BIOS version (6.0.3) to properly 
utilize the Windows 2003 Server Operating System.  By default, all systems shipped after GA 
automatically include this BIOS version.   

For some maintenance activities, the BIOS should be upgraded before installing CallPilot 3.0 
(03.03.06.02) and Windows 2003 Server OS from a CallPilot Image CD.  

Note: The semi-automatic update process includes steps that repartition and format your hard drive.  
This will result in the loss of all data on the hard-drive.  If only the BIOS update is desired, use the 
manual process below. 

Note: If after completing either the manual or semi-automatic process, the system pops up a Windows 
Activation window, manually enter the product key information from the Certificate of Authenticity 
(COA) that was shipped with the system/software and reboot the server.  If no COA was received, 
contact Order Management for a replacement. 
 

Manual process to update the 201i BIOS: 

1. Power on the server. 
2. Insert the CallPilot 201i Image CD into the CD-ROM drive. 
3. Enter the BIOS setup program by pressing <F2> at the “Press F2 to enter SETUP” 

prompt. 
4. Use the left/right arrows to select “Advanced”. 
5. Use the up/down arrows to select “Installed O/S:”. 
6. Use the +/- keys to change the value to “Other”. 
7. Press <F10>. 
8. Select “Yes” to confirm that the changes should be served. 
9. After the server reboots, enter ‘Y’ when prompted “BOOT ROM DOS (Default to No in 5 

seconds) (Y/N)” in order to launch ROM DOS. 
10. When the ROM DOS Startup menu is displayed press <F8> to enable confirmation of the 

DOS configuration.  You can verify that this is enabled by checking that the N changes to a 
Y at the bottom of the screen. 

11. Select “1. SCSI CD-ROM” by entering 1 and pressing <Enter>. 
12. You will now be prompted to confirm each line in the config.sys and autoexec.bat file.  

Press ‘Y’ to accept the 1st line “STACKS=9,256”. 
13. Press ‘Y’ to accept the 2nd line “NUMLOCK = ON”. 
14. Press ‘N’ to not accept the 3rd line “DEVICE=A:\DOS\HIMEM.SYS…”. This is required 

since you can not flash the BIOS if himem is loaded. 
15. For all of the remaining questions, press ‘Y’ to accept the line. 
16. At the A:\ command prompt navigate to the CD ROM (Z:\biosutil\) and run phlash.exe 

to upgrade the BIOS. 
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Semi-automatic process to update the 201i BIOS: 

1. Perform steps 1-9 as above. 
2. Navigate to Z: and run Phase1.bat, system will reboot after. 
3. After the server reboots, enter ‘Y’ when prompted “BOOT ROM DOS (Default to No in 5 

seconds) (Y/N)” in order to launch ROM DOS. 
4. Navigate to Z: and run Phase2.bat, system will reboot after. 
5. After the server reboots, now by default, server will boot from C: drive 
6. On prompt “1. Update BIOS”, press <Enter> 

 
NOTE: After updating the BIOS, if you boot from the hard drive again before you install CallPilot 
from image, you would receive a prompt like this: 
 

1. Re-do BIOS update 
2. Reboot 
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Appendix D: Updating the 1002rp BIOS 
 
CallPilot 1002rp Rackmount servers running release 3.0 (03.03.06.02) require BIOS version 
(NNCXUA07) to properly utilize the Windows 2003 Server Operating System.  By default, all systems 
shipped after GA automatically include this BIOS version.   

For some maintenance activities,  the BIOS should be upgraded before installing CallPilot 3.0 
(03.03.06.02) and Windows 2003 Server OS from a CallPilot Image CD.  

You can choose to update 1002rp BIOS by following the steps below: 
 

1. Disconnect the CLAN network cable. 
2. Insert the CallPilot 03.03.06.02 Image CD – Disk 1 that is appropriate for the platform type 

that is being recovered into the CD-ROM drive. 
3. Power on the server. 
4. Set the BIOS to boot from CD-ROM. 
5. When the server boots from the CD-ROM, select option 2 “Utilities (BIOS, Firmware, 

etc...)” and press <Enter>. 
6. Choose option 1 to “Update 1002rp BIOS to version NNCXUA07” 
7. When prompted to same existing BIOS, choose “No” (N). 
8. When prompted to program the boot Block, choose “Yes” (Y) 
9. When prompted to enter the file name, type “NNCSAU07.ROM” 
10. Press “Y” to continue 
11. After upgrade is complete, the system will prompt for reboot. 

 
During the boot process, check the version of the BIOS on the top of the screen in the first boot 
screen.  If it is not NNCXUA07, check if jumpers J10 and J11 are both on the top positions.  You will 
need to power off the system and remove the SBC for this operation.  Ensure ESD rules are followed 
or damage to board may occur due to static electricity.  
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Appendix E: Updating the Mega-RAID Firmware 
 
703t Tower and 1002rp Rackmount servers could have either the MegaRaid Elite 1600 or MegaRaid 
Elite 320-2 RAID card installed.  The firmware update process is as follows: 
 

1. Perform a RAID consistency check 
2. Perform a full-system backup 
3. Disconnect the CLAN network cable. 
4. Insert the CallPilot Image CD – Disk 1 that is appropriate for the platform type that is 

being recovered into the CD-ROM drive. 
5. Power on the server. 
6. Set the BIOS to boot from CD-ROM. 
7. When the server boots from the CD-ROM, select option 2 “Utilities (BIOS, Firmware, 

etc...)” and press enter. 
8. Choose either option 2 to “Update firmware for MegaRaid Elite 1600” or option 3 to 

“Update firmware for MegaRaid Elite 320-2” depending on your RAID card type. 
9. Allow the F/W to update.  At the end of the procedure, the system will prompt to reboot. 
10. Once the reboot is performed, the F/W upgrade is complete. 
11. Split the RAID 
12. Re-image the server 
13. Restore from full-system backup 
14. Re-sync the drives 
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Appendix F: Using Microsoft RDC 
 

This appendix is an excerpt from Product Bulletin P-2005-0026-Global “CallPilot 3.0 and the 201i IPE 
Platform – Using Microsoft Remote Desktop Connection”.  It is included here as technical reference 
providing information needed for personnel to acquire, install, and use the RDC client to access 
CallPilot 3.0 systems.   For complete details, refer to the Product Bulletin. 
 
Please read this section in its entirety since several important issues and workarounds are 
described.   If not followed, the user will likely encounter the following conditions: 
 

• Errors connecting 
• Problems entering passwords 
• Confusion on how to share the screen 
• Support tools will not work properly 
• PEP installs will not work properly 
• MAS Trace window will not be visible 

 
 
The following topics are covered in this section: 
 

• Procedures: 
o Install Remote Desktop Connection Client 
o Enable Remote Desktop feature and Set policy on host 
o Establish a RAS connection 
o Starting the Remote Desktop Client 

 Method 1: Private Session (preferred method) 
 Method 2: Shared Session (only if local console is logged on) 

 
• Advisements: 

o CallPilot Support Tools 
o RAS dial-up required to establish RDC 
o “Double-Hop” remote control 
o Transferring Files in Remote Desktop Connection Session 
o Terminal Server Maximum Connections Exceeded Error 
o Disconnecting the Remote Desktop Connection Session 
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1.  Remote Desktop Connection Client Installation 

The Remote Desktop Client software is installed by default on Windows XP Professional and on 
Windows Server 2003.  However, the version for Windows Server 2003 is slightly different from the 
Windows XP version.  Obtain the Windows Server 2003 version of the Remote Desktop Connection 
Client from the following link: 
 
http://www.microsoft.com/downloads
 
 
This software can be installed on client PCs running Windows 95, Windows 98, Windows ME, 
Windows NT 4, Windows 2000, or Windows XP using the following procedure: 
 

1.1. Run the executable (msrdpcli.exe).  InstallShield will scan the computer to prepare installing 
the client. 

 

 
 

1.2. Once complete, the “Welcome” window will appear:  
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1.3. Click “Next >” to proceed.  The End User License Agreement window will appear:  
 

 
 

1.4. Accept the License agreement, click “Next >”. 
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1.5. Enter the appropriate User/Organization information and click “Next >” to continue. 

 

 
 

1.6. Click “Install” to install the client. 
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1.7. Once all software has been installed, “Completed” window will appear. 
 

 
 

1.8. Click “Finish” to close the wizard window. 
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2. Enable Remote Desktop feature and Set policy on host 

All CallPilot 3.0 and later servers come with the Remote Desktop server enabled and configured for use 
by default.   
 
THERE IS USUALLY NO NEED TO PERFORM THE STEPS SHOWN IN THIS 
SECTION. 
 
If necessary, Remote Desktop access can be enabled or disabled as follows. 
 

2.1. From the CallPilot server desktop, right-click on My Computer and choose Properties, then 
click on the Remote tab. 

 

2.2. Ensure the “Allow users to connect remotely to this computer” checkbox is selected.  Click 
“OK” to close this window. 
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2.3. There are five (5) options available for remote control settings.  To choose among options, 
you need the Group Policy Snap-in.  Open a command prompt window by clicking Start > 
Run.  In the “Open” window type “gpedit.msc” and click “OK” or press <Enter>. 

 

2.4. On left side of window, expand Computer Configuration, expand Administrative 
Templates, expand Windows Components, and then select Terminal Services.   

 

2.5. On right side of the window, double-click on “Sets rules for remote control terminal 
services user sessions”.  Select “Enabled” and  five (5) options are available: 
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2.6. Adjust the set settings as required and click “OK” to close the window. 

The default and recommended setting for CallPilot is “Enabled” with Option “Full 
Control without User’s permission” selected.  This allows for RDC sessions without 
requiring interaction/consent from a local console user. 

2.7. Use File > Exit to close the “Group Policy Object Editor” window. 
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3. Establish a RAS connection 

If the CallPilot server is not directly accessible from the Client PC via an intranet or VPN, it will be 
necessary to establish a Remote Access Service (RAS) connection.  This is unchanged from previous 
CallPilot releases – using Dial-up Networking from the Client Windows PC.   
 
Note:  The details of using Dial-up Networking vary depending on which version of Windows 
Operating System is running on the Client PC.  Refer to the CallPilot NTPs, Windows Help, or other 
Microsoft documentation for details.   
 
The following example is from a client PC running Microsoft Windows 2000 Professional. 
 
Connect to the CallPilot server using Dial-Up Networking.  Use the NGenDist or NGenSys accounts 
since these accounts are enabled for dial-up access.  You will need the password for the account. 
 

3.1. Right-click the connection icon in the system tray and choose Status (or just double-click the 
icon).  The RAS “Status” window appears. 
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3.2. To obtain the IP address, select the “Details” tab. 
 

 
 

3.3. From the “Details” tab, note the Server IP address.  (192.168.0.1 in this example).  
  
3.4. Close the Dial-Up Networking Status window by clicking “Close”. 
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4. Starting the Remote Desktop Client 

4.1. Method 1: Private Session (preferred method) 

Use this method when needing to perform the following tasks: 
 

• Establish a private login session remotely, not visible from the server console. 
• Utilize the CallPilot Support Tools  
• Transfer files from local PC to the CallPilot server 
• Install a PEP/Service Update that interacts with the CallPilot database 
 

Note:  If the local console is already logged in, it will get forcibly logged out (unsaved data will be lost).  
Your actions will not be visible on the local console. 
 

1. From the client PC, start the Remote Desktop Connection for Windows Server 2003 
Client.  The usual shortcuts are:   

• Start > Programs > Remote Desktop Connection 

• Start > Programs > Accessories > Communications > Remote Desktop 
Connection 

 

Note:  When using the “/console” suffix, this assures a private session connected to the 
logical console of the CallPilot server.   

Note:  A space character exists between the last digit of the IP address (or computer name) 
and the “/console”.   

Note:  Older versions of RDC only support  “/console ” suffix using DOS window 
command line.    

For a dial-up RAS connection, use the IP address for the Dial-Up server as shown in the 
preceding section.   
 
For intranet or VPN connections, you may use the computer name instead of an IP 
address. 
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2. Click the “Options >>” button: 

 

3. Fill in the Computer (name or IP address with a “space” character before “/console”), 
User name and Password.  Click the “Local Resources” tab: 
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The “Local Resources” tab allows you to specify that the Disk drives and Printers from the 
client PC are to be made available on the target CallPilot server.   Recommended settings: 

• Remote Computer Sound: Leave at remote computer 

• Keyboard:   On the remote computer 

• Local Devices: Note:  Disk Drives must be checked to 
enable transferring of files (SU/PEP, logs, 
traces, etc) to and from the CallPilot server. 

The “Display” tab allows you to specify the screen size and colors for the remote desktop 
connection.  Recommended settings: 

• Remote Desktop size:  800x600 

• Color Depth:   High Color (16 bit) 

The “Experience” tab allows you to specify the connection speed (broadband or modem) 
that the connection will be optimized for.  Recommended settings: 

• Performance:   Modem (28.8 Kbps) 

• Bitmap caching:   Enabled 

4. Click “Connect” to create the remote desktop connection.  The following “Security 
Warning” window will appear. 
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5. Click “OK” to continue 
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6. A remote desktop session will be started in a window on the client PC.   
 
Example of RDC session (with an open “My Computer” window): 

 

You can maximize the window to make it full screen.  The CallPilot “MAS Trace Window” 
should be visible on the taskbar.  By default, this is a private session which cannot be seen from 
the CallPilot local console.  All disk drives from the client (including floppy and CD drives) will 
be mapped to the CallPilot server.  Files can be transferred by copying them using Windows 
Explorer. 

If the RAS connection drops, the Remote Desktop Connection will be disconnected.  You can 
dial back in to re-establish the RAS connection.  Then reconnect using Remote Desktop Client 
in the same way.  You will see any windows you left open. 
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4.2. Method 2: Shared Session (only if local console is logged on) 

Use this method when one or more of the following conditions are true: 
 

• Need a “shared” login session where you are able to see exactly what is on the local console and 
all tasks are visible from the server console.  (i.e. during mentoring sessions, or investigating an 
existing alarm message displayed on the console, etc.) 

• When no transfer of files between the local PC to the CallPilot server will occur 
 
You can choose to start a shared session as follows: 
 

1. From the client PC, start the Remote Desktop Connection for Windows Server 2003 
Client.  The usual shortcuts are:  

• Start > Programs > Remote Desktop Connection 

• Start > Programs > Accessories > Communications > Remote Desktop 
Connection 

 

2. Click the “Options >>” button: 
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3. Fill in the Computer (name or IP address), User name and Password.   
 
For a dial-up RAS connection, use the IP address for the Dial-Up server as shown in 
the preceding section.  Click the “Local Resources” tab: 

 

The “Local Resources” tab allows you to specify that the Disk drives and Printers from the 
client PC are to be made available on the target CallPilot server.  Recommended settings: 

• Remote Computer Sound: Leave at remote computer 

• Keyboard:    On the remote computer 

• Local Devices: Note: Disk Drives must be checked to 
enable transferring of files (SU/PEP, logs, 
traces, etc) to and from the CallPilot server. 

Note:  Disk drive sharing is needed to be able to transfer files to and from the CallPilot 
server.  While file transfer is not possible in a “shared” session, it’s recommended this setting 
still be selected. 

The “Display” tab allows you to specify the screen size and colors for the remote desktop 
connection.  Recommended settings: 
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• Remote Desktop size:  800x600 

• Color Depth:   High Color (16 bit) 

The “Experience” tab allows you to specify the connection speed (broadband or modem) that 
the connection will be optimized for.  Recommended settings: 

• Performance:   Modem (28.8 Kbps) 

• Bitmap caching:   Enabled 
 

4. Click “Connect” to create the remote desktop connection. 

 

5. Click “OK” to continue. 

6. Then, within the Remote Desktop session, start a command prompt and enter the 
command “shadow 0”:  

• Start > Run, then in the “Open” box enter “cmd” and click “OK”. 

• Within a command prompt window, type “shadow 0” and <Enter> 
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This will put your private session on hold and will start a shared session, allowing the local and 
remote consoles to share/view the same thing.  All your remote actions will be visible on the 
local console.  Both the local and remote mouse and keyboard are active.  The screen resolution 
of the Remote Desktop Connection will be adjusted to match the resolution of the local 
console.  The disk drives shared from the client PC are not visible after you enter the “shadow 
0” command.  
  
The CallPilot desktop background will be visible during a shared session.  This can slow 
performance if you are connected over a modem.  You can turn off the background using 
Control Panel > Display > Desktop tab (set it to None).  Once completed with your shared 
session, remember to set the background back to its original setting:   
 

Start > Settings > Control Panel > Display > Desktop tab  
 
(browse to path: C:\windows\system32\CP3BackSplashs\ CPBAKxxxx.bmp where 
xxxx = platform number)  

 
To cancel shadowing of the CallPilot console and return to the original session, hold the CTRL 
key while pressing the * key on the numeric keypad.  The shared disk drives will again be 
visible.  You can toggle back and forth using shadow 0 and CTRL num *. 
 
Note:  If no numeric keypad exists (e.g. using a laptop), use the Function and * keys. 
 
Note:  If you logout while in a shared session, console shadowing will end and you will revert 
to your initial private session.  The local console session will be logged out. 
 
Note:  PEP installs and CallPilot support tools may not work properly when you are in an un-
shadowed session not connected to the console. 
 
Note:  While in a “shadow 0” session, you will be unable to see your local drives on the remote 
server. 
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Note:  If the local console is not already logged on when the “shadow 0” command is used, the 
system will return the following error within the Command prompt window: 

Remote Control Failed.  Error 7050 
Error [7050]:The requested session cannot be controlled remotely. 
This may be because the session is disconnected or does not currently have a 
user logged on. 

You can still connect to the console session by logging out from your RDC session, then 
reconnecting using the /console option (Method 1). 
 
 

5. CallPilot Support Tools 

Certain support tools and operations (including PEP installs) will work properly only when run from the 
logical console.  MMFS and database operations can only be done from the logical console session.  
These tools must be run using either Method 1 (a private session connected to the console) or by using 
Method 2, after entering “shadow 0” (i.e. a shared session connected to the console).  Once you cancel 
console shadowing, support tool operations may not work unless you re-shadow. 
 
If you wish to use support tools without the customer being able to see on the console, use Method 1 to 
create a private session.  This will log out any local user.  Note that you can start and stop Remote 
Desktop sessions without dropping the RAS dial-up connection. 
 
Note:  PEP installs that perform database or MMFS operations may also require use of a session 
connected to the console. 
 
Note that there is no way to send the "CTRL-ALT-DEL" key combination.  If you need to reboot the 
CallPilot 3.0 server, use "Start - Shutdown".  (Although this method of restarting caused problems with 
the database on earlier CallPilot software releases, it does not cause any problems on CallPilot 3.0) 
 
To disconnect finally, you log out from the NGenDist session.  This will close any programs you started 
and terminate the Remote Desktop Client.  You can then hang up the RAS connection. 
 
 

6. RAS dial-up required to establish RDC 

Unfortunately it is not possible to use Remote Desktop directly through a modem.  RAS dial-in must be 
working for this form of remote access to work. 
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7. “Double-Hop” remote control 

A common support scenario is for one technician to dial in to a customer’s CallPilot server, then 
another technician controls the first technician’s computer (e.g. via intranet or VPN), thereby gaining 
access to the dial-up remote control session on CallPilot.  For this to work, the intermediate computer’s 
Dial-Up Networking TCP/IP Settings must have the setting “Use default gateway on remote network” 
unchecked.   
 
This can be modified using the following procedure: 

7.1. Double-click the Dial-up Networking connection icon in the system tray.  The “Status” 
window will appear. 
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7.2. Click the “Properties” button.  The “Properties” window will appear. 
 

 
 

7.3. In the “Properties” window, select the Networking tab. 
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7.4. Highlight the Internet Protocol (TCP/IP) component and click the “Properties” button.  
DO NOT un-check “Internet Protocol (TCP/IP). 
 

 
 

7.5. In the Internet Protocol (TCP/IP) Properties window, click the “Advanced” button. 
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7.6. In the Advanced TCP/IP settings, uncheck the setting "Use default gateway on remote 
network".   Click “OK” to close all windows.  The following “warning” will appear. 

 

 
 

7.7. Disconnect and re-connect to the remote server.  The modified “Default gateway” setting will 
now be active. 
 

 
Note:  It is possible to use pcAnywhere to control a PC that is in turn connected into a CallPilot server 
via Remote Desktop Connection.  However, the right keyboard shift key does not seem to work in this 
scenario, nor does the CAPS LOCK key.  You must use the left shift key only to input upper case 
characters.  This is especially important when typing passwords.  (This problem was noted using 
pcAnywhere 10.5 and 11.01). 
 
Note:  Double-Hop remote control is also possible using two Remote Desktop Connections if the 
intermediate PC is running an OS that includes the Remote Desktop Connections Server.  This works 
fine, however it can be a little confusing if both sessions are in full-screen mode.  Refrain from 
maximizing the Remote Desktop windows to see them nested. 
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8. Transferring Files in Remote Desktop Connection Session 

Before a file can be transferred between a local computer (the computer that is launching the Remote 
Desktop Connection and making the remote support connection session) and the remote CallPilot 
server, the local disk drives must be made available during the Remote Desktop Connection logon 
session. 
 
As noted in sections 4.1 and 4.2, ensure the “Local devices” settings include the local “Disk Drives” to 
enable file transfer while in a Remote Desktop Connection session: 
 

 
 
While in a session, moving files between the local computer and the remote CallPilot server can be done 
within an Explorer window.  If the “Local devices” setting for Disk Drives was checked during the 
initial connection, the local drives will be displayed in the “Other” section as indicated in the following 
example: 
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9. Terminal Server Maximum Connections Exceeded Error 

CallPilot supports a maximum of two (2) remote sessions and one (1) console session concurrently.  If 
these limits are exceeded, when trying to start a Remote Desktop session you might receive the 
following error: 
 

 
 
If this occurs, it is still possible to make a connection without the need for local intervention.  Just use 
Method 1 as described in section 4.1 to connect.  This will force any local user to logout and will allow 
you to connect. 
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10. Disconnecting the Remote Desktop Connection Session 

You should not terminate a Remote Desktop Connection by simply clicking “X” on the Remote 
Desktop Window.  This will disconnect your session, but the session will continue to exist on the 
CallPilot server.  Any programs you were running will continue to run.  You can connect again and see 
the same session. 
 
If you are finished with remote support, you should LOG OFF your session.  This can be done using 
Start > Logoff, or Start > Shutdown >Logoff. 
 
To log off and end the Remote Desktop Connection session: 
 

10.1. In the Remote Desktop Connection window, click “Start”, and then “Log Off 
<username>”.   The following confirmation window will appear.  Click “Log Off” to exit 
the Remote Desktop Connection session. 

 

 
 
10.2. Alternatively, in the Remote Desktop Connection window, click “Start”, and then 

“Shutdown”.  When the “Shut Down Windows” dialog appears, select “Log Off 
<username>”, from the “What to do” box and then click “OK”. 

 

 

 
Nortel – Document # P1002957  Page 101 of 105 



11. View/Disconnect concurrent or previous “stale” sessions 

Microsoft Windows Terminal Services Manager provides the administrative user the ability to see 
different sessions that are active or in-active on the server.   
 
This tool can be used to logoff and/or disconnect any leftover sessions that are no longer needed.  It 
can also be used to send messages to other sessions for messaging between users. 
 
The tool is available using: Start > Programs > Administrative Tools > Terminal Services Manager.  
Similar functionality is also available from the Users tab of the Task Manager. 
 
Example of Windows Terminal Services Manager (Users): 

 
 
Example of Windows Terminal Services Manager (Sessions): 
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12. Troubleshooting 

The following provides troubleshooting information/workarounds for scenarios that might be 
encountered while using Microsoft RDC. 

12.1. Session disconnected unexpectedly  

If while in a private console session (e.g. using “192.168.0.1 /console”) another user takes 
away the console (either local to the server, or another remote RDC session), the following 
message is displayed: 

 

Tip:  Contact the site to arrange for access, or use a “shared” session (Method 2) and then 
message the other user via Windows Terminal Services Manager or Task Manager. 

12.2. Receive “The server name specified is invalid” message when trying to connect using 
“/console” switch, Method 1. 

If using an older version of Microsoft Remote Desktop Connection client, and enter a server 
name of “192.168.0.1 /console”, the following message is displayed: 

 

Tip:  Upgrade to the newer Windows 2003 RDC client (this document references version 
control 5.2.3790.0).  To check the RDC client version, right click the title bar, and select 
“About”. 
 
Workaround:  If the RDC client can’t readily be upgraded, the following alternative steps 
may also be used: 

a. Open a command prompt window on your client PC 

b. Enter “mstsc /console” and press <Enter>.  The RDC window is now visible. 
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c. Enter the IP address of the server into the “Computer” field. 
 

 

12.3. Unable to transfer files to the remote CallPilot server 

If unable to see local client PC files/folders from within the RDC client session, either or 
both of the following conditions may apply. 

Scenario #1:  If the Local Devices/Disk Drives option was not checked within the Options 
window before connecting to the remote server, the local files/folders will not be visible from 
within the RDC client. 

Scenario #2:  If connected to the CallPilot server using a shared session (“shadow 0”), files 
will not be visible and therefore cannot be transferred. 
 
Workaround: When transferring files between the CallPilot server and RDC client PC, use 
Method-1 “Private” session.   

12.4. Connection to server is extremely slow 

When using RDC, the access speed is diminished if the Desktop Background setting is turned 
ON.   

Workaround:  If using Method-1 (Private session using the “/console” switch), prior to 
connecting, under Options, in the “Experience” tab, ensure that “Desktop Background” in 
unchecked.   

If using “Method-2 (Shared session using “shadow 0” command), after connecting, and 
logging onto the server, right-click on the Desktop, select Properties, then select the 
Desktop tab.  In the Background selection box, choose “None”.   
Click “OK” to close the window. 

12.5. “Shadow 0” session fails with error “Remote Control Failed. Error 7050” 

If the local console is not already logged on when the “shadow 0” command is used, the system 
will return the following error within the Command prompt window: 

Remote Control Failed.  Error 7050 
Error [7050]:The requested session cannot be controlled remotely. 
This may be because the session is disconnected or does not currently have a 
user logged on. 

Workaround:  Connect to the console session using the “/console option” (Method 1).  This 
method does not require a user be logged on already. 
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12.6. System Monitor and/or Support Tools do not return valid/legible information. 

If you connect to the CallPilot server using Method-2 but without issuing the required 
“shadow 0” command, and then attempt to run various Support Tools/Diagnostics that 
access the database, each may return invalid results.   
 
For example, when Launching System Monitor: 

 

 

Workaround: Use as documented Method-1 or Method-2 (with the required “shadow 0” 
command) when connecting to the CallPilot server. 
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